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2 INTRODUCTION 
 Download the CPY server firmware: 

www.gavazziautomation.com/FIRMWARE/cpy_firmware.zip  

 Download the UWP 3.0 Tool: 

www.gavazziautomation.com/UWP3.0_TOOL_SW_DOWNLOAD.pdf 

2.1 General description 
Welcome to the CPY Software manual. This guide will cover the essentials of setting up 
and using the CPY software included with your Dupline® 3 Parking Guidance System. We 
will start with a brief description of the system. 

The Dupline® 3 Parking Guidance System is built up of a number of hardware and software 
components. The most common components in the system are the Dupline® 3 Parking 
Sensors. These are installed in each parking bay. A bay sensor detects when a bay is 
occupied and reports it to the Dupline® Master it is connected to, as well as indicating it 
with a coloured light. This coloured light is also used to indicate if the space is booked.  

2.2 System Architecture 
The SBP2CPY is a micro PC with Web-Server and Web-Service capabilities suitable for 
gathering information from up to 10 UWP 3.0s. In a project with more than one UWP 3.0 
controller, the SBP2CPY module is required. 

If only one UWP 3.0 controller is used in the Car Park project, the CPY Server is integrated 
into the controller: the address to access it is:  

[UWP 3.0 IP address] /CP3App 

e.g., 192.168.2.71/CP3App 

2.3 Applications 
The SBP2CPY aggregates data from multiple controllers in a single centralized database. 
You can access from anywhere by Web Browser, through a highly interactive interface, in 
order to manage the entire parking lot. The main features are as follows: 

 Booking bays with scheduled actions or from the overview 

 Checking the bay sensors in alarm 

 Viewing the real-time status of each bay sensor with drawings and reports 

 Setting the Bay sensor’s category and status  

 Configuring the Displays and Indicators 

 Secure remote connection through the Carlo Gavazzi MAIA Cloud solution 

 

All the data is available as charts, tables and reports based on an XLS format. 
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3 SYSTEM REQUIREMENTS 

3.1 Browser 
The CPY Web-Server is a software application that runs in a Web Browser. To ensure 
optimal performance, the recommended browser is Google Chrome, a modern browser 
that you can download free of charge. 

4 ACCESS TO THE SYSTEM 

4.1 Network configuration 
To access the system, you first need to establish a network connection between your PC 
and the SBP2CPY: you have the following options: 

 Directly connect the two devices (SBP2CPY and PC) through a network cable. 
Technical support operators can also communicate with the SBP2CPY through 
the same LAN port, using the IP address 192.168.253.254 (this address is fixed 
and cannot be changed).  
 

 Connect both devices (SBP2CPY and PC) to your local network 
 

 Directly connect the two devices (SBP2CPY and PC) through a USB/mini-USB 
cable. If using a mini-USB cable to connect the devices, use the IP address 
192.168.254.254. 
 

The SBP2CPY IP settings are factory-configured to start as DHCP. 

 

4.1.1 Discover the SBP2CPY IP address via the UWP 3.0 Tool 
To find the SBP2CPY IP address, click on the icon marked in red to start the discovery:  
 

 
 
The following window will appear with all the SBP2CPYs in the network:  
 

 
 
Note: Please check the relevant UWP 3.0 Tool documentation for further information concerning 
the exchange data with UWP 3.0 controllers. 
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4.1.2 Access the SBP2CPY Web-Server 
After the IP address of the SBP2CPY has been discovered, you can access the Web-
Server. Follow this procedure in order to grant the access: 

Step Action 

1 Open a Web Browser and type the URL, based on the device used: 

 Device CPY Server URL 

SBP2CPY 
SBP2CPY IP address  
e.g. 192.168.2.73 

SBP2WEB/UWP3.0 [Controller IP address]/CP3App 
e.g. 192.168.2.71/CP3App 

 

2 Enter the username and password in the Login page, as shown below: 

 

The default username and password are shown in the table below: 

Username Password Name Level 

admin admin admin administrator 

Security Note: To prevent any undesired access to the system, it is 
recommended that you modify the default password during the first 
configuration. 

3 Click the Login button to access the Main page 

 

After you have granted the access, you can change the IP settings (see Specify an IP 
address manually). 
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4.1.3 Access remotely the SBP2CPY Web-Server with MAIA Cloud* 
 
*MAIA Cloud is the Carlo Gavazzi PaaS (Platform as a Service) solution that allows a 
seamless connection of different remote devices through SBP2CPY24 units, so to develop 
the necessary car park guidance solutions by connecting and setting the relevant items. 
Users who have access to the MAIA Cloud can easily reach the gateways and the 
endpoints, provided they have the necessary access rights, using a PC and a standard 
browser. 

Notes:  

 For more information about MAIA Cloud, see the MAIA cloud user manual  

 MAIA Cloud is compatible with SBP2CPY24 version 2.6.3 onwards. 

 For more information about the device activation, go to How to activate SBP2CPY24 
in MAIA Cloud 

 
 
Follow this procedure to set up a remote connection to a device activated in MAIA Cloud: 

1. Log in to your MAIA Cloud (link here) 
2. Open the home page or the main menu and go to Devices > VPN 
3.  

If you want to… Then… 

Use a predefined application to create 
a VPN tunnel to the gateway 

You can 

a. Click Chevron-Down to open the Connection drop-down 
menu of the device 

Or  
b. Click on the device you want to connect in the 

map and click Applications to open the 
Connection side panel 

After that, click one of the available applications. 
 
If the connection is correctly established, the status icon 
becomes green. 

open all the ports of the application 
which composed the device and 
endpoint profile 

You can 

a. Click Ellipsis-V > Connect from the Action menu of the 
device 

Or 
b. Click Chevron-Down to open the Connection drop-down 

menu of the device and click Connect 
Or 

c. Click on the device you want to connect in the 
map and click Connect 
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After that, you can enter the Virtual IP address that you 
find in the Connection drop-down menu or side panel, 
in your browser or in your application. 

Disconnect from the 
endpoints/gateway 

You can 

a. Click Ellipsis-V > Disconnect from the Action menu of the 
device 

Or 

b. Click Chevron-Down opening the Connection drop-down menu 
of the device and click Disconnect 

Or 
c. Click on the device you want to disconnect in the 

map and click Disconnect 

 

4.2 Main page 
The figure below shows the CPY server main page: 

 

 

 

Main page 

 

When you access the Web Server main page, you can see the following areas, which are 
always available while using the software. The different areas are as follows: 

  

B 

D 

A

C 
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Area Description 

A The navigation bar located at the top of the main page has the following tabs:  

Tab Description 

 User Settings for e.g. language and date/year 

It is necessary to run the CPY with correct date and time format 
(Europe/US) 

 System 
settings 

To select LAN, Modem, Clock and Firmware 
It is necessary for LAN or Modem settings, together with the Clock. 
The clock is needed for real time stamp and for internal use of the 
clock. Always check for the latest firmware release 

 Settings To select General park settings such as Account, status/category 
setup 

The first three menus must be completed because the settings have an impact on the 
future database in the carpark software. The last two menus (Group settings and 
Scheduler) can be filled out later. They are used for e.g. booking and sending data to 
emulated displays 

 Drawings To add drawings and design Car Park structures  

In this menu, you can build up the entire structure for the Car Park 
project. Drawings can be imported and icons can show the status of 
status of each bay, such as Vacant, Occupied, Disabled, VIP etc. 
Physical displays with steady or moving arrows can be assigned 
and configured and reproduced displays can be configured to show 
specific status, such as the number of occupied bays, VIP bays in 
one floor or the entire system. 

 Layout Option for personal screen view. E.g. Status page and alarm page 
as preferred screen view  

This menu is optional but can be used to personalize each user’s 
screen layout. It shows the menus as a cascade or in layers. The 
user can decide which menus are in focus 

 Alarms See historical alarms and acknowledge alarms. It is also possible to 
set different alarm set point for groups or individual bays  

It is optional but useful for e.g. investigating the time each car has 
been parked with a selectable time limit or a complete group of cars. 

| Status Displays the entire parking lot as bar graphs or as a table 

Optional, but gives the operator useful information about occupancy 
on each floor or entire system 

 Report 
For occupancy and space statistic 
Optional but useful for historical investigations of space and area 
statistic such as occupancy, available spaces, most used /not used 
spaces in either as graph or as table 

 Commands E.g. sequence setup to control a gate when carpark is occupied  

Optional but useful to control e.g. a gate when floor/all is occupied 
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B The left panel contains the hierarchical tree view of the entire parking lot structure as 
created in the UWP 3.0 Tool. 

Note: the left panel can be hidden by pressing the  button 

C The main area shows the drawing and status windows, the reports window, etc.. 

D The right panel displays the SBP2CPY date and time, and some information about the 
status of all the UWP 3.0 controllers that are part of the current project, as follows: 

 

Status Description 

 

The UWP 3.0 controller is connected with the 
SBP2CPY 

 

The UWP 3.0 controller is not connected with 
the SBP2CPY 

Note: the right panel can be hidden by pressing the  button 
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5 USER 
If you click on the User tab (the label shows the username currently connected) from the 
navigation bar, the following menu will appear: 

 

 

6 CPY USER SETTINGS 

6.1 User interface 
The CPY user settings window is where you view or change the language setting and the 
date and time formats. 
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6.2 Procedures 

6.2.1 Change default language 
To set the system language, follow this procedure: 

Step Action 

1 Click on the User (e.g. Admin) tab from the navigation bar, then click User 
International Settings  

2 From the Language drop-down menu select the desired language 

 

3 Click on Save to store the changes 

 
 

6.2.2 Change date and time format 
To set the system date and time format, follow this procedure: 

Step Action 

1 Click on the User (e.g. Admin) tab from the navigation bar, then click User 
International Settings 

2 From the Date format drop-down menu select the desired format: 
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3 From the Time format drop-down menu select the desired format: 

 

4 Click on Save to store the changes 

 

6.2.3 Change the password for a non-administrative user 
The user without administrative privileges, who cannot access the Account settings 
window, but is allowed to change the password, can follow this procedure: 

 

Step Action 

1 Click on the User tab from the navigation bar, then click Change user password 

2 Enter the current password in the Current password box, then type the new 
password in the boxes below: 

 

3 Click on Save to store the changes 

Note: the following message will appear to confirm the password has been 
updated correctly: 
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6.2.4 Log-off from the system 
 

To Log-off a user from the CPY webserver, click on the User tab from the navigation bar, 
then click on  Disconnect.  

The current user will be logged-out and will return to the login page. 
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7 SYSTEM SETTINGS 
If you click the System settings tab from the navigation bar, the following menu will 
appear: 

 

 

Use the System settings menu to view system information and make system settings. 
The menu includes the following sections, shown in the table below: 

Section Features 

 System Info  See the device information (such as the serial number, the 
Mac address, the firmware version) 

  LAN settings  Configure the IP address of the SBP2CPY 

 Configure the DynDNS parameters 

  Modem settings Configure the network parameters of the 3G modem for the 
internet connection. 

Note: the SH2DSP24 accessory module is required 

  Clock setting Set the date and time used by the SBP2CPY 

  Firmware Upgrade the firmware of the SBP2CPY module 

  Tools  Reboot the SBP2CPY 

 Restore to factory settings 

 Backup / Restore  Backup and restore the data 

 Modbus TCP Slave  Create the Modbus map 

 Export the Modbus map 
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Section Features 

 BACnet  BACnet configuration 

 BACnet settings 

VPN settings  Manage the MAIA Cloud VPN remote connection 

 Check the VPN connection status 

Note: The System Settings menu is ONLY available for the SBP2CPY24 Server 
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8 LAN SETTINGS 

8.1 User interface 
The LAN settings window is where you view or change network information such as the 
IP address of the SBP2CPY and the DynDNS parameters. 

 

 

LAN settings window 

 

 

8.2 Things to know 

8.2.1 Network communication 

The SBP2CPY module must be installed and connected to the same local area network 
(LAN) of the UWP 3.0 controllers of the Car Park Guidance installation. A valid IP address 
must be assigned, manually or automatically, to communicate with the other network 
devices. The parameters are: 

Parameter Description 

IP address The IP address is the LAN IP address assigned to the SBP2CPY. 
It must be unique in the local area network. 

Subnet mask The mask is the subnet mask of the LAN to which the SBP2CPY 
is connected. 

A

B 
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Default gateway This is the IP address of the computer or device on your network 
that connects your network to another network, or to the Internet. 

Note: the default gateway is only mandatory if you plan to access 
SBP2CPY through the Internet using the LAN connection  

DNS server The Domain Name Server (DNS) address is used to look up site 
addresses based on their names. Use the DNS server if you want 
to reach SBP2CPY from the internet. 

 

8.2.2 Dynamic IP address (DynDNS) service 
To access your SBP2CPY from the Internet, when a static public IP address is not 
available, you can use a commercial Dynamic DNS service: the DynDNS service lets you 
register your domain to their IP address and forwards traffic directed at your domain (see 
“B” area) to your frequently changing IP address. The SBP2CPY can be reached by a 
user-friendly Internet name, such as SBP2CPY.dyndns.org 

 

8.3 Procedures 

8.3.1 Specify an IP address manually 
By default, the IP address is automatically acquired from a DHCP server when the 
SBP2CPY is switched ON. 

To manually assign a static IP address to the SBP2CPY (e.g. if a DHCP server is not 
available in the LAN) follow this procedure: 

 

Step Action 

1 Click on LAN settings from System settings menu 

2 In the IP address box, type the IP address of the SBP2CPY 
e.g. 192.168.1.100 

3 In the Subnet mask box, type the subnet mask of the local network 
e.g. 255.255.255.0 

4 In the Default gateway box, type the IP address of the default gateway of 
the local network 
e.g. 192.168.1.254 
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Step Action 

5 DNS servers: 
 select  to automatically get the DNS server address check-box to 

acquire the DNS server automatically from the DHCP server 
 or select Use the following DNS server addresses to manually 

specify the addresses in the Preferred DNS server and Alternative 
DNS server boxes 

Note: The Alternative DNS server is not mandatory 

6 Click on Submit to save the new network settings. 

Note: click the  icon to close the window without saving any changes: the 
SBP2CPY will keep the current network settings. 

  

Note: the SBP2CPY needs a restart, which is performed automatically; wait until the count-
down is over; then you will be routed back to the main page.  

 

8.3.2 Get an IP address automatically (DHCP) 
If the SBP2CPY is set with a static IP address, follow this procedure to change it to obtain 
an IP address automatically from the DHCP server. 

 

Step Action 

1 Click on LAN settings from the System settings menu  

2 In the Network settings window check  to automatically get an IP address 

3 Click on Submit to save the new network settings. 

Note: Click on the  icon to close the window without any changes and keep 
the current network settings. 
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8.3.3  Set up the DynDNS service 
To enable the management of the dynamic public IP address, follow this procedure: 

 

Step Action 

1 Register for an account with one of the Dynamic DNS service providers whose 
URLs are in the Service provider list 

For example, for DynDNS.org, select www.dyndns.org 

2 Click on LAN settings from the System settings menu  

3 Select the  to enable the dynamic DNS check box 

4 Type the chosen Dynamic DNS server  

5 Type the Hostname that the chosen provider DynDNS gives you 

6 Type the Username provided during account registration 

7 Type the password provided during account registration 

8 Click on Submit to save the new network settings. 

Note: the service will be available after about 6 minutes. 

  

 

  



 

   

                                                

 CPY Server - Manual                        29 

 

 

9 MODEM SETTINGS 

9.1 User interface 
The Modem settings window is where you view the modem connection status and 
configure the internet connection settings when the modem is used.  
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The Modem setting window includes 4 areas: 

Area Description 

A Information about the modem data connection: 

 

Parameter Description 

Signal Modem signal level (Rx) 

Type Modem model (third party p.n.) 

Network 
registration 

The name of the ISP to which the modem is connected 

Data 
connection 

Connection status 

IP address IP address assigned to the device by the ISP 

  

B Configuration of the network parameters of the 3G modem for internet 
connection 

C Password setting required for security reasons to send SMS command 

See the list for all the SMS commands available 
 

D It is possible to resolve common issues in mobile communication by means of 
two different mechanisms, such as ping reboot and scheduled reboot 

 

9.2 Things to know 

9.2.1 Internet Service Provider 
To access the Internet through a 3G connection some parameters need to be requested 
from the mobile company (ISP): APN (Access Point Name), available network (HSPA....), 
optional dial up number. 
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9.3 Procedures 

9.3.1 Modem configuration 
You need to install the SH2DSP24 adapter module before configuring the modem, then 
follow this procedure: 

 

Step Action 

1 Click on Modem settings from System settings menu  

2 Select from the Enable modem combo-box 

3 Select the  Enable Internet connection check box to enable data 
communication via the Internet 

4 Select OTHER from Provider combo-box 

Note: Select predefined Vodafone IT M2M to load the predefined Vodafone APN 
configuration. Steps 5 to 9 may then be ignored 

5 Enter service Provider name in�APN box  

6 Enter *99# or *99***1# in Phone Number box 

7 Leave Username box blank if the username is not required by the ISP 

8 Leave Password box blank if the password is not required by the ISP 

9 Click on Save to store the modem settings. 

 

9.3.2 Set the password for SMS commands 
To enable the 3G modem to accept SMS commands through the SIM, follow this 
procedure: 

Step Action 

1 Click on Modem settings from the System settings menu  

2 Select the  Enable SMS check box to enable SMS alarm dispatching 

3 Enter a numeric password in Password box 

e.g. 1234 

4 Re-enter the same password in Confirm Password box 
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9.3.3 Modem watchdog 
To solve common issues in mobile communication, follow this procedure:  

Command Action 

Enable 
ping 
reboot 

If enabled, the SBP2CPY sends a PING command to the defined Website / 
IP address chosen in the Website/IP Address box. 

In case of repeated lost answers from the PING command, the system 
reboots 

Enable 
scheduled 
reboot 

The system reboots at each timed interval, chosen in the Time interval box 
(hours) 
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10 CLOCK SETTINGS 

10.1 User interface 
The Clock settings window is where you can set the system date and time for the 
SBP2CPY module. 

Note: The SBP2CPY and the UWP 3.0 controllers belonging to the Car Park project should 
be synchronized with the same NTP server(s). 

  

The menu includes the following sections, as shown below: 

Section Features 

Manual settings Set the date and time manually 

Synchronize with PC 
clock 

Date and time are automatically synchronized with the 
internal clock of the PC 

Set time zone Set the time zone where the SBP2CPY is located 

NTP service Specify the NTP server to obtain the date and time from time 
servers 
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10.2 Things to know 

10.2.1 NTP service 
The NTP server can be used to obtain the date and time information from one of several 
network time servers on the Internet.  

Note: an internet connection is required for the SBP2CPY to give this information 

 

10.3 Procedures 

10.3.1 Set date and time manually 
To set the system date and time manually, follow this procedure: 

Step Action 

1 Click on Clock settings from the System settings menu  

2 In the Set system date/time section, click on the   icon 

3 Select the date from the popup calendar 

 

 

 

 

 

4 Enter the current time in the box  

 

Please see SBP2CPY user settings for the date and time format  

5 Click on Set time to store the new settings. 

 

  

Click on the arrows to select the month through 
months 

Click on the month to select the year 
through years 
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10.3.2 To synchronize with PC clock 
To synchronize the date and time automatically with the PC clock, follow this procedure: 

Step Action 

1 Click on Clock settings from System settings menu  

2 Click on Set time in the Synchronize with PC clock section 

3 Close the Clock settings window to store the new settings 

 

10.3.3 Set the time zone 
To set the time zone where the SBP2CPY is located, follow this procedure: 

Step Action 

1 Click on Clock settings from the System settings menu  

2 In the Set Time Zone section: 

 choose your Zone from the drop-down menu  

 choose your Location from the drop-down menu 

3 Click on Set time zone to store the new settings 

 

10.3.4 Set NTP service 
To set the NTP Service, follow this procedure: 

Step Action 

1 Click on Clock settings from the System settings menu  

2 Select the  Enable NTP service to turn it ON 

3 Type a valid NTP server in the Primary server box  

e.g. ntp1.inrim.it 

4 Type a valid NTP server in the Secondary server box  

e.g. ntp2.inrim.it 

5 Click Save to store the new clock settings 
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11 FIRMWARE 

11.1 User interface 
The Firmware window is where you can check and update the firmware version of the 
SBP2CPY. 

  

 

11.2 Things to know 

11.2.1 Firmware package 
A firmware update is a single binary file that contains the entire firmware payload              
([firmware_revision].bin) of the SBP2CPY module.  

Carlo Gavazzi regularly releases new firmware versions to improve product performance 
or to introduce new functionality. 

The upgrade is highly recommended every time a new release is available. 
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11.3 Procedures 

11.3.1 Firmware update 

To update the SBP2CPY module with a new firmware revision, follow this procedure: 

Step Action 

1 Download the latest firmware available from the Carlo Gavazzi web site, save 
it to your Desktop and unzip the archive if necessary. 

Note: The correct firmware file uses a .bin extension 

2 Click on Firmware tab from the System settings menu 

3 Click the Browse button 

4 Locate and highlight the saved firmware and click the Upload button: the 

firmware package will upload into the SBP2CPY, see the uploading 

progress on the browser bar  

 

Note: Click on the Clear button if you have selected the wrong file. 
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Step Action 

5 Click on Start upgrade, the firmware update operation will start, where the 
following window can be seen: 

 

Note: When uploading firmware to the SBP2CPY, do not interrupt the web 
browser by closing the window, or loading a new page. If the browser is 
interrupted, it could corrupt the firmware. 

6 Your SBP2CPY will reboot after the firmware is uploaded. 

 

Note: The upgrade process depends on the present SBP2CPY load (in terms of connected 
devices), the Internet connection speed and the size and complexity of the update 
package. 
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12 TOOLS 

12.1 User interface 
If you click on the  System settings tab from the navigation bar, then  Tools, the 
following window will appear: 

 
 

 

Tools window 

 

Section Features 

A Remote Reboot turns your SBP2CPY module OFF and then ON. When 
rebooting, all the user will be disconnected.  

B System data reset sets the SBP2CPY module back to its default settings and 
will allow you to reconfigure it based on your Car Park project. 

 

  

A 

B 
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12.2 Procedures 

12.2.1 Remote reboot 
To reboot the SBP2CPY module, follow this procedure: 
 

Step Action 

1 Click on System settings from the navigation menu, then click Tools tab 

2 Click the Reboot button 

3 On the Confirm popup, click Yes button 

 

NOTE: Observe the Power light on the SBP2CPY when rebooting. It goes OFF 
and then ON as an indication that the module is going through the process.  Wait 
for few minutes to finish the process. 

 

12.2.2 System data reset 
To restore SBP2CPY to factory settings, follow this procedure:  

Step Action 

1 Click on System settings from the navigation menu, then click Tools tab 

2 Enter the password of an admin user with privileges permission 

 

Note: the password must match, otherwise you cannot continue with the restore 
operation 

3 Click the Restore factory settings button 

4 The SBP2CPYmodule reboots and will be restored to factory settings 

WARNING: Do not interrupt the restore process 
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Step Action 

5 Click on Start upgrade, the firmware update operation will start, where the 
following window can be seen: 

  

Note: When uploading firmware to the SBP2CPY, do not interrupt the web 
browser by closing the window, or loading a new page. If the browser is 
interrupted, it could corrupt the firmware. 

6 Your SBP2CPY will reboot after the firmware is uploaded. 

 

Note: The Restore procedure does not affect firmware which will remain the latest one 
installed 
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13 BACKUP / RESTORE 

13.1 User interface 
The Backup/Restore window is where you can manage the backup and restore process 
in order to have a snapshot of your Car Park database. An SD card is required for backup 
and restore operations. The maximum SD card capacity supported is up to 32 GB. 

If you click on the  System settings tab from the navigation bar, then  Backup / 
Restore, the following window will appear: 

 

  

The menu includes the following sections, as shown below: 

Section Features 

Backup setting Sets the backup options 

Backup/Restore Logs Shows the backup processes that have been executed 

Recover Selects an available backup to be restored 
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13.2 Procedures 

13.2.1 How to create a complete backup 

This option creates a complete backup of the SBP2CPY24 database. 

Note: Backup and restore operations can take a considerable amount of time due to 
the size of the database 

To create a new complete backup, follow this procedure: 

Step Action 

1 Click on the Backup/Restore tab from the System settings menu 

2 In the Backup setting tab, the SD information shows if an SD Card is 
available. Otherwise please insert an SD Card into the module 

3 Click on the Execute button to start the process 

4 Click on the Save button to store the changes 

 
You can check in the Backup/restore Logs tab the backup status 
 

13.2.2 How to schedule a complete backup 

This option makes the complete backup of the SBP2CPY24 database. 

To schedule a complete backup, follow this procedure: 

Step Action 

1 Click on Backup/Restore tab from the System settings menu 

2 In the Backup setting tab, the SD information is shown to notify that a SD 
Card is available. Otherwise please insert a SD Card into the module 

3 Checks the Enable checkbox to enable the backup process 

4 In the Backup type combo box select the Complete option 

5 In the Set date and time field you have to select the point in time when 

the backup will take place 

6 Click on the Save button to store the changes 
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13.2.3 How to create an incremental backup 

 

This is the automatic backup of your SBP2CPY24 database that occurs every 4 hours. 
To set the Incremental backup, follow this procedure: 

Step Action 

1 Click on the Backup/Restore tab from the System settings menu 

2 In the Backup setting tab, the SD information shows if an SD Card is 
available. Otherwise please insert an SD Card into the module 

3 In the Backup type combo box select the Incremental option 

4 Click on the Save button to store the changes 

 
The system will automatically create an incremental image of the database every 4 
hours. You can check the backup status in the Backup/restore Logs Tab 
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13.2.4 How to check the backup status 
 
In the Backup/restore Logs tab you can check the list of the backup operations that have 
been performed. 
 

 
 
This table shows the list of the backup records that have been created. It has the following fields: 
 

Field Description 

Type This field shows the type of operation 

Backup name This field shows the backup name 

Status This field shows the status of a backup operation 

Progress This field shows the progress status of the operation 

Backup size This field shows the total size of the backup 

Start This field shows the starting time of the operation 

End This field shows the ending time of the operation 
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13.2.5 How to restore a backup from an SD Card 
In the Recover tab of the Backup/Recovery settings window you can restore a previous 
backup that has been created from an SBP2CPY24 module. A backup can be restored 
on the same module or, in case of a disaster recovery, the backup can be restored on a 
new SBPCPY24 module.  
 
To restore an available backup from an SD Card, follow the steps below: 
 

Step Action 

1 Click on the Backup/Restore tab from the System settings menu 

2 In the Recovery tab, select the backup image from the Select backup 
combo-box: 

 

3 Click on the Start recovery button 

4 To start the recovery operation, click on the Yes button: 

 

 
Note: Backup and restore operations can take a considerable amount of time 
due to the size of the database  
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14 MODBUS TCP SLAVE 

14.1  User interface 
The Modbus TCP Slave window allows you to read the status of the Car Park server via 
Modbus TCP. The available signals are: 

 

 Modbus signals related to modules; 
 

 Modbus signals related to functions; 

 

You can access the Modbus TCP Slave window by selecting Modbus TCP Slave from the 
System setting menu: the following window will appear: 

 

 
 
The Modbus TCP Slave window includes these sections: 
 

Area Description 

A 
In the Modbus TCP Slave Configuration section, you can configure the 
Modbus protocol 

B 
In the Modbus TCP Slave Commands section, you can export the Modbus 
map using different formats 

 
  

A 

B 
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14.2 Procedures 
 

14.2.1 How to enable and configure the Modbus TCP protocol 
 

Follow this procedure to enable the Modbus TCP protocol in the SBP2CPY24 module: 

Step Action 

1 In the Modbus TCP Slave configuration check the flag to enable the protocol 

2 
In the Port field you have to enter the communication port for Ethernet connection 
(by default 502) 

3 Click on the Save button to store the changes 

 
 

14.2.2 How to create the Modbus map 
The Modbus map can be saved as a .csv file: to generate it you can follow the steps below: 

 

Note: All the Modbus addresses can also be saved as a PDF file by clicking on the Export 
PDF map button (this shows the same info as the .CSV file but in PDF format). 

  

Step Action 

1 Click on the Generate map button: the following message will appear to confirm that the 
Modbus map has been created correctly 

 

2 Click on the Export CSV map button to save the Modbus map as a CSV file 
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14.2.3 How to update the Modbus map 
 

Important: Any time any changes are made in the project the Modbus map has to be updated. 

Follow the steps below to generate an updated version of the Modbus map: 

 

14.2.4 How to reset the Modbus map 
 

If all the Modbus addresses have to be reset and a new map is needed, you can Reset the 
map. Follow the steps below to reset the map: 

 

  

Step Action 

1 Click on the Update map button: the following message will appear to confirm that the 
Modbus map has been updated correctly 

 

2 Click on the Export CSV map button to save an updated version of the Modbus map as a 
CSV file 

Step Action 

1 Click on the Reset map button: the following message will appear to confirm that the 
Modbus map has been reset correctly 

 

2 Click on the Export CSV map button to save the Modbus map as a CSV file 
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15 BACNET 

15.1 User interface 
The SBP2CPY24 operates as a server on BACnet/IP. This allows BACnet clients such as 
DDC controllers and building management systems to read and control the SBP2CPY24 
functions. Two different groups of BACnet objects are managed:  

 

 BACnet objects related to modules; 
 

 BACnet objects related to functions 
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15.2 Procedures 
 

15.2.1 How to select the BACnet objects 
 

In the menu BACnet configuration, under the System settings menu, you can define 
which BACnet objects have to be managed. Follow these steps below: 

 

15.2.2 How to create the EDE-files 
 

To create the EDE files, follow the steps below: 

 

15.2.3 How to Regenerate the BACnet map 
 

If all the BACnet objects have to be reset and a new BACnet map is needed, follow the 
procedure below: the user has to click on the Bacnet management icon and press 
Regenerate BACnet objects button, as shown below. 

 

  

Step Action 

1 Tick the BACnet objects to be used 

2 In the column Instance number, you can change the number by clicking the box 
and entering a new instance number 

Step Action 

1 Tick the BACnet objects to be used 

2 Click on the Check data button to verify that the objects are correctly defined  

3 Click on the Export button to save the EDE files 

Step Action 

1 Click on the Regenerate button in the BACnet configuration window 

2 Click on the Check data button to verify that the objects are correctly defined  

3 Click on the Export button to save an updated version of the EDE files 
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15.3 Basic settings for instance numbers 
In the System settings menu, select BACnet settings. You can change the instance 
number for CPY device object (default:5000). 

 

 

 

For the other BACnet object types that appear (Binary Input, Binary Output, Analog Input, 
Analog Output, Analog Value, Multi-state Input, Multi-state output, Bitstring value) there is 
the possibility to define the start instance number for each object type. The CPY server will 
then assign the first created object of this type with the entered instance number, and the 
rest of the objects of this type will be assigned the following numbers consecutively. The 
individual instance numbers can still be changed manually in the signal view menu if 
desired. 
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16 SETTINGS 
By clicking on  Settings tab from the navigation bar, the following menu will appear: 

 

 

 

Use the Settings menu to view information about the Car Park Guidance installation and 
make settings. The menu includes the following sections, as shown below: 

  

Section Features 

 General settings Set the name of the Car park installation 

 Account Users and permissions management 

Note: this window is only accessible to users with 
administrative rights 

○ Status/categories setup Defines the status and categories of the bays 

  Group settings Defines new groups that are an arbitrary aggregation of 
various elements: 

 Bays 

 Real groups (Sensor line, Lane, Zone) 

 MZC groups (Master Zone Counter) 

 Scheduler Defines the scheduled job-activities 

 Remote Server Configures the Digital input Car Park remote server 
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17 VPN SETTINGS 
The VPN settings menu allows you to manage the MAIA Cloud VPN remote connection 
and check the VPN connection status. 

 

Notes:  

 For more information about MAIA Cloud, see the MAIA cloud user manual  

 MAIA Cloud is compatible with SBP2CPY24 version 2.6.3 onwards. 

 

17.1 User interface 
The VPN Settings window includes the following parameters: 
 

 
 

Parameter Description 

Enable If you check it, the VPN service will be available for that device. 

Activation 
code 

The Carlo Gavazzi UWP-ACTIVATION-KEY which allows you to activate 
the device in MAIA Cloud. 
 
For further details, see the How to activate SBP2CPY24 in MAIA Cloud 

Select 
server 
type 

Note: The Standard MAIA Cloud Server has to be set. 
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Parameter Description 

VPN 
Status 

○ The green icon means that the device is available and you can 
connect to it through VPN. 
 
○ The red icon means that the device is disconnected, and you cannot 
connect to it through VPN. Following are the possible reasons of this 
condition: 
Wrong activation key. 
Wrong DNS or network gateway settings. 
Wrong settings in MAIA Cloud. 
 
○ The grey icon means that the VPN service is disabled. Check the 
Enable field to use the VPN service. 
 

 

 

17.2  Procedures 

17.2.1 How to activate SBP2CPY24 in MAIA Cloud 
1. Open a browser 
2. Log in to your MAIA Cloud organization (https://app.maiaconnect.com) 
3. Click Bars to open the Main menu  
4. Go to Devices > Activate  
5. Complete the activation with the following information:  

 Device Label (device name)  
 Latitude and longitude for the location  
Note: you can navigate the map or use the search box. 

 UWP-ACTIVATION-KEY. Write the activation code included in your UWP-
ACTIVATION-KEY kit.  

For further information, go to Activation key user manual. 

6. Click Check 
7. Go to your MAIA Cloud home page 
8. Click Ellipsis-V > Assign credit to enable the VPN service for your device. 

Note: to assign credits, you need at least one unused VPN month. To add resources to 
your organization, you need a UWP-LICENCE code (for further information, go to Licence 
code user manual). 

9.  

If you use the version… Then… 

2.6.3 onwards in few seconds SBP2CPY24 will be 
online 
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If you use the version… Then… 

2.6.3 backwards 10. Update your SBP2CPY24  
Note: the VPN service is available in the 
SBP2CPY24 version 2.6.3 onwards. 

11. Log in to the CPY server 
12. Go to System settings > VPN 

settings 
13. Enable the service 
14. Write the activation code of your 

UWP-ACTIVATION-KEY kit 
Note: The Standard MAIA Cloud Server 
has to be set. 

15. Click Save 
Note: ○ the green icon means that the 
procedure is successfully finished. 

 

17.3  Things to know 
 

17.3.1 MAIA Cloud ports 

17.3.1.1 Inbound communication (through the tunnel) 

TCP/IP port number TCP/IP port description Purpose 

80 HTTP Access the internal web-server 

443 HTTPS Access the internal web-server 

52325 SSH 
Remote tunneling; connection from UWP 
3.0 to SBP2CPY24 

17.3.1.2 Outbound TCP/IP communication 

TCP/IP port number TCP/IP port description Purpose 

53 DNS Domain name resolution 

37 NTP Access the network time services 

17.3.1.3 For tunneling 

Access Ports 

MAIA Cloud Web 443/tcp and 1194/udp 

MAIA Cloud Connector App software 443/tcp and 1194/udp 

Note: all the above-mentioned ports are supported for the tunneling service. 
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18 ACCOUNT 

18.1 User interface 
User Management includes administrative tools to help the administrators manage and 
control user permissions.  

Note: this window is only accessible to users with administrative rights 

 

 

Accounts window 

This section includes information about how contract administrators can manage and 
control user access to the CPY webserver. The Account window includes 2 areas: 

Area Description 

A (User list) Only users with administrative rights can: 

 Add users 
 Edit users 
 Delete users 

 

A B 
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Area Description 

B (Details and 
Permissions) 

Modify user permissions  

Note: an existing user must be selected in the user list before 
changing their rights 
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18.2  Things to know 

18.2.1 Users and permissions 

The user list is the primary interface for managing users. By clicking on a user from the 
list (A area) the following information are shown: 

 Detail Description 

Username Defines the unique identifier of the user account 

Default layout Defines the layout applied when the user logs-on to the system 

Password and 
Confirm password 

Defines the password the user account should have 

Administrator rights Indicates whether or not a user is an administrator. Administrative rights 
allow access to the User Management function 

Account disabled If this setting is enabled, the user will not be able to log-on. This is to be 
used as a security precaution. It might be used, for example, if a new 
employee needs to be added to the system but his account does not 
need to be active yet 

Change password This prevents the user from changing the password 

A user's permission determines what they can and cannot do in the SBP2CPY solution. 
A user with administrative rights can change (add or remove) the permissions for a user. 
The following sections describe these permissions. In general: 

 Permission Description 

Edit drawing Defines whether a user can access the edit functionality of Drawing 

Edit layouts Defines whether a user can access the edit functionality of Layouts 

Edit groups Defines whether a user can access the edit functionality of Groups 

System 
configuration 

Defines whether a user can manage the System settings 

Edit scheduler Defines whether a user can access the edit functionality of Schedules 

Edit alarm settings Defines whether a user can modify Area Alarms settings and Space 
Alarm 

Alarm 
acknowledgement 

Defines whether a user can acknowledge alarms in Alarm>Status 

Book and unbook 
bays 

Defines whether a user can book/unbook parking spaces 

Send sequences Defines whether a user can send sequences to the UWP 3.0 controllers 
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 Permission Description 

Web service 
permission 

Defines whether a user can manage the Web service permission (WEB-
API)  

18.3  Procedures 

18.3.1 Add new user 
Note: ONLY the administrator accounts will be present in the list 

To add a new user, follow this procedure: 

Step Action 

1 Click on Account from Setting menu 

2 Click on Add new user below Users list 

3 In the Details section (B area): 

 Enter the username  
 Select a Default layout from the drop-down list 
 Enter the password in the password and Confirm password boxes 

4 In the Options section (B area): 

 Select  check-box to manage the options required 

5 In the Permissions section (B area): 

 Select the  check-box to manage the permissions required 

6 Click the Save button to add the user: 

Note: if you have filled out all the information correctly, you will see a message 
informing you that the user has been created 

 

Otherwise, an error message will inform you which part of the form has been 
filled out incorrectly 
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18.3.2 Edit user 

Once you have selected the required user from the list, follow this procedure to edit the 
user account: 

Step Action 

1 Click on Account from Setting menu 

2 Select the user you wish to modify from the User list 

3 In the Details section (B area): 

 Change the Default layout from the drop-down list 
 Enter the password in the password and Confirm password box. 
Note: The username cannot be changed  

4 In the Options section (B area): 

Select the  check-box to manage the options required 

5 In the Permissions section (B area): 

 Select the  check-box to manage the permissions required 

6 Click the Save button to save the changes 
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18.3.3 Delete users 
You cannot delete the user you are currently logged on to, as in the account window 
the Delete user button is not clickable. 

To delete a user, follow this procedure: 

 

Step Action 

1 Click on Account from Setting menu 

2 Select the user you wish to delete from the User list 

3 Click on Delete user button 

4 Click Yes on the confirmation dialog to confirm the action 

 

Note: the following message will appear to confirm the user has been deleted 
correctly, otherwise you will be given an error message detailing what went 
wrong 
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18.3.4 Change password 
Once logged on, you can change the password from the first tab (User), by following this 
procedure: 

 

Step Action 

1 Click on Change password from User menu 

2 In the Password configuration window: 

 

 Type the password used to log on to the CPY in Current password 
 Enter your new password in New password, then enter it again in Confirm 

password 

3 Click on the Save button to store the new password 
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19 STATUS/CATEGORIES SETUP 

19.1  User interface 
The Status/categories setup window is where you view or change the attributes of the 
bays’ sensors and the icon appearance of your Car Park project. 

 

 

Status/categories setup window 

 

 

 

 

A 

B 

C 

D 
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The window includes 4 sections: 

Section Description 

A 
To select the icon set to show the status and category in the drawing 
windows. 
 
Note: this is related only to the CPY webserver 

B 
Defines the attributes of the bay sensor and icon, in order to identify 
their status 

C 
Defines the attributes of the bay sensor and icon, in order to identify 
the category to which they belong. 

D Defines the attributes of the bay sensor and icon in order to identify 
the category based on event 

19.2 Things to know 

19.2.1 Bay status and category 
The picture below shows an example of a drawing window in the CPY webserver 
 

 

 

Example – a drawing window 

 
 
Each car’s icon represents a parking space and the icon represents the current status and the 
category to which they belong. In this guide a parking space is referred to as a BAY. 
 
The status is the condition a bay is in and it is monitored in real-time by the software: the different 
statuses, Occupied, Unknown, Error, are represented by different icons so you can have a clear 
view of your parking lot. The categories to which the bays belong can be defined according to the 
Car Park project properties.  
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In the tables below you can see the meaning of each icon's colouring/pattern, as well as how 
many bay sensors in the drawing have this status right now. 
 

 Status Default property 

Occupied Bay has car  

Note: All occupied bays are represented by icons in the occupy 
colour (default is RED) 

Error Bay has its sensor in error 

Unknown Bay is in an unknown status (e.g. at the start-up of SBP2CPY 
before UWP 3.0 controller sends bay events) 

 
 

Note: Vacant is the status when a bay has no car; each bay in the vacant status could be set in 
one of the 7 available categories.  

The table below shows the default properties: 

 

 Category Default property 

Normal Green colour 

Disabled Blue colour 

Reserved Orange colour 

Expectant Mothers Purple colour 

VIP Yellow colour 

Electrical Vehicle Charging Cyan colour 

Valet Violet colour 
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19.3  Procedures 

19.3.1 Change the icons set 
You can select, as global settings, the icon to represent the bay in the Normal, Error and Unknown 
statuses. Follow these steps to change the set: 

Step Action 

1 Click on Status/categories setup from Settings menu 

2 In the Icon set selection click the combo-box: 

3 Select the icon set: 

 

The icons are used only in the CPY webserver 

4 
Click on Save settings to store the changes 

 

19.3.2 Change name, colour and flashing behaviour 
You can change the attributes for each status and category, configurable by: 
 

Step Action 

1 Click on Status/categories setup from Setting menu 

2 In the Category settings, in the Name column, you can change the name of the default 
categories. 
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Step Action 

3 In the Colours column, you can select the colour from the combo box: 

 

Note: the OFF colour is represented by black. 

4 In the Icon flashing column, select the behaviour to be applied to the icons used 
in the CPY webserver. You can choose from: 

 Steady 

 Flashing 

5 In the Sensor LED flashing column, select the behaviour to be applied to the bay 
sensor LED. You can choose from: 

 Steady  
 Flashing 0.5 
 Flashing 1.0 
 Flashing 2.0 

 

6 In the Enables column, select the  check-box to manage the Category required 

7 Click on Save settings to store the changes 

 

19.3.3 Remove existing categories 
You can remove existing categories. Follow this procedure: 
 

Step Action 

1 Click on Status/categories setup from Setting menu 

2 In the Enables column, deselect the  check-box to manage the Category required 
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Step Action 

3 
 

 

4 Click on Save settings to store the changes 
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19.3.4 Set events based on categories 
You can create events based on categories status. Follow these steps to add: 
 

Step Action 

1 Click on Status/categories setup from Setting menu 

2 In the Event based categories settings section, in the Name column, you can change 
the name of the default event. 

3 In the Colours column, you can select the colour from the combo box: 

 

Note: the OFF colour is represented by black. 

4 In the Icon Flashing column, select the behaviour to be applied to the icons used 
in the CPY webserver. You can choose from: 

 Steady 

 Flashing 

5 In the Sensor LED flashing column, select the behaviour to be applied to the bay 
sensor LED. You can choose from: 

 Steady  
 Flashing 0.5 
 Flashing 1.0 
 Flashing 2.0 

 

6 In the Enables column, select the  check-box to manage the event based category 
required 

7 Click on Save settings to store the changes 
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20 GROUPS SETTINGS 

20.1 User interface 
The Groups settings window is used to define and manage new groups, which are an 
arbitrary aggregation of various elements: 

 Bays 

 Real groups (Sensor line, Lane, Zone) 

 MZC groups (Master Zone Counter) 
 

 

Groups settings window 

The Groups settings window includes 2 areas: 

Area Description 

A Navigation bar: the commands available are as follows: 

Command Action 

 Create new group 

  Edit group 

− Delete group 

 Create MZC group 

 Split MZC group 
 

B Shows the available groups and MZC groups 

A 

B 
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20.1.1 New/edit group window 
The New/Edit group window appears by clicking on the Create new group and Edit 
group option: 

 

 

New/edit group window 

 

The window includes 2 main areas: 

 

Area Description 

A 
Groups 
This section controls which bays (sensors) are listed under 
Available spaces area 
 
Available spaces 
A list of available spaces in the group selected, which are not 
already added to the new group 

B Spaces in group 

A list of spaces added to the new group 

 

  

A B 
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20.2 Things to know 

20.2.1 Groups definition 

A group is the whole of bays in a delimited zone, such as a floor, a delimited perimeter, an 
area, etc. 

You can create a new group starting from the existing groups that are sent by the UWP 
3.0 Tool. They can be seen in the left panel of the CPY webserver, as shown in the red 
rectangle in the picture below: 

 

A Car Park project, typically, consisting of several floors: in this example, there are three 
floors: Roof, Floor2 and Floor1. 

The virtual groups are useful when:  

 You have to manage Master Zone Counter (MZC) groups 

 You have to monitor a delimited zone of your Car Park project 
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20.3  Procedures 

20.3.1 Create new group 

To create a new group, follow this procedure: 

Step Action 

1 Click on Groups settings from Settings menu 

2 Click on  Create new group from command bar; the New Group window 
appears 

3 In the name box enter the name of the new group 

4 From the Groups select a desired group: 

Note: A list of available spaces in the selected group are shown 

5 Select a space from the Available spaces section. 

Note: to select multiple spaces, select a space and hold shift to add 
several, or hold  

CTRL to select individual spaces 

6 Adding spaces to a group 

Click the  button to add the selected spaces to the 
Spaces in group section 

7 Removing spaces from a group 

To remove one or more spaces,  

1. Select space(s) from the Spaces in group section 

2. Click the  button to remove the selected spaces 
from Spaces in group. 

3. The selected spaces will be added to the Available spaces section 

Note: to select multiple spaces, select a space and hold shift to add 
several, or hold  

CTRL to select individual spaces 

8 Click on Save button to create the new group 
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20.3.1.1 Example 

The example below shows a new named Disabled_bays with K5 and K6 sensors. The new 
group is shown in Group settings window and it appears in the Group panel of CPY 
Webserver  

 

 
20.3.2 Edit a group 

To edit an existing group, follow this procedure: 

Step Action 

1 Click on Groups settings from Settings menu 

2 Select a group from the list 

3 Click on  Edit group from command bar: 
the Group window appears with the properties of the selected group 

4 Adding spaces to selected group 

Click the  button to add the selected spaces to the Spaces in 
group section 
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Step Action 

5 Removing spaces from the selected group 

To remove one or more spaces,  

1. Select space(s) from the Spaces in group section 

2. Click the  button to remove the selected spaces from 
Spaces in group. 

3. The selected spaces will be added to the Available spaces section 

Note: to select multiple spaces, select a space and hold shift to add several, or hold  

CTRL to select individual spaces 

6 Click on Save button to store the changes 

 

20.3.3 Delete a group 

To delete an existing group, follow this procedure: 

Step Action 

1 Click on Groups settings from Settings menu 

2 Select a group from the list 

3 Click on − Delete group from command bar; the selected group will be removed 

 
Note: All the spaces which were part of the deleted group will be reassigned to the 
original group of the car park structure, sent by the UWP 3.0 Tool 
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20.4 User interface 

20.4.1  Master Zone Counter (MZC) group 
The MZC group window appears by clicking on the  Create MZC group button from the 
Group settings command bar: 

 
 

 

MZC group window 

 

The window includes 2 main areas: 

 

Area Description 

A 
Groups 
This section shows the available MZC groups  
 
Note: The Master zone counter (MZC) functions have to be created by 
the UWP 3.0 Tool. See the UWP 3.0 Tool Car Park Manual 
 

B Spaces in group 

Shows the groups merged together to make the MZC group 

 

 

A B 
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20.5 Things to know 

20.5.1 Operating principles of the MZC group 

The MZC functions represent the status of a Car Park area monitoring the entrance and 
exit points by counter sensors (DPO). The Master Zone Counter can work as a stand-alone 
zone count system or in a mixed solution together with the Car Park single spot detection 
system (lane sensors). 

The picture below shows an MZC Area with a total of 12 bays: 10 bays are standard and 
2 bays are equipped with lane sensors. Note: The MZC bay icons are not available 
 

 

 

Example – a drawing window 

 

The MZC functions must be created in the UWP 3.0 Tool, please refer to the UWP 3.0 
Tool; The CPY webserver is in charge of the following operations:  

 

 MZC function is combined with a lane sensor group 
 

 The MZC value can be Reset / Set manually or scheduled by an action 
 

 Union of two MZC groups 

 

 
 
  

MZC Normal bays 

MZC Normal bays 
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The CPY web server offers the functionality to manage the split between standard bays 
(e.g. Normal bays) and reserved bays (e.g. Disabled bays). The reserved bays are 
implemented as a single space system where each bay is equipped with a Car Park lane 
sensor, the total number of standard bays in a Car Park Area is managed by MZC 
function from the UWP 3.0 Tool.  

 

20.5.1.1 Example of an MZC area with lane sensors bays inside. 

As illustrated in the figure above, a Master Zone Counter Area has a total number of 12 
parking lots where 10 bays are standard and 2 bays are equipped by lane sensors. 

 

 

All 12 bays are counted by the MZC function but the status of 2 Disabled bays are managed 
by the lane sensor. In order to perform the right counts, you can create a new virtual group 
as a union of two groups. the two groups above must be combined by means of a MZC 
group functionality, otherwise the system counts 14 bays instead of 12 bays.  

The precise reserved bay availability information being achieved is calculated by the MZC 
Group as: 

MZC vacant bays = MZC function value - Lane sensor bays 

In the figure shown on the left, the groups 
involved in MZC are represented in the CPY as 
follows: 
 
(Fx) Roof MZC is the MZC function defined in 
the UWP 3.0 Tool for standard bays 
 
Roof_disabled is a virtual group created in the 
CPY that defines the lane sensor bays for 
reserved bays 
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The table below shows an events example 

Event MZC Occupied 
bays (Normal 
+ Disabled) 

Disabled 

Occupied/Total 

MZC Normal 
bays 
Occupied/Total 

The MZC area has no cars 

 

0/12 0/2 0/10 

A car enters in the MZC area 
and parks in a bay reserved 
for Disabled category 

 

1/12 1/2 0/10 

A second car enters in the 
MZC area and parks in a 
Normal bay  

 

2/12 1/2 1/10 
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Event MZC Occupied 
bays (Normal 
+ Disabled) 

Disabled 

Occupied/Total 

MZC Normal 
bays 
Occupied/Total 

A third car enters in the MZC 
zone and parks in a Normal 
bay  

 

3/12 1/2 2/10 

The car parked in the 
Disabled bay leaves the 
area, the MZC value is still 
the same. 

 

2/12 0/2 2/10 

A car parked in a Normal bay 
leaves the area, the MZC 
value will be updated 

 

1/12 0/2 1/10 

Note: the MZC bays have not got any available icon that can be used in a Drawings. In the 
example above it is used this       symbol for a better understanding.  
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20.6 Procedures 

20.6.1 Create an MZC group (Union of an MZC function and a 
lane sensor group) 

To create an MZC group, combining an MZC function and a lane sensors virtual group, 
the result is a new virtual group that is the union of the two groups, follow this procedure: 

Step Action 

1 Click on Groups settings from the Settings menu 

2 Click on  Create MZC group from the command bar; the MZC group 
window appears 

3 In the Groups section of the window, select the MZC function and the lane 
sensors group you need to merge into a new MZC group 

Note: you must select at least one MZC function created in the UWP 3.0 Tool 

4 Click the  button to add the selected groups in the Spaces 
in group section 

5 Repeat steps 3-4 to select any other group to be added to the Spaces in 
group section 

6 Click on the Save button to create the new MZC group, it will be added in the 
Group settings window. 

N.B. The new MZC Group is also added in the Groups panel as a new node. 

A * symbol is added to the ending 
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20.6.2 Edit a group 

To edit an existing MZC group, follow this procedure: 

Step Action 

1 Click on Groups settings from Settings menu 

2 Select an existing MZC group from the list 

3 Click on  Edit group from command bar: 

the MZC group window appears with the properties of the selected MZC group 

4 Edit the group then click on Save button to store the changes 

 

 
20.6.3 Split an MZC group 

To split an existing MZC group, follow this procedure: 

Step Action 

1 Click on Groups settings from Settings menu 

2 Select an existing MZC group from the list 

3 Click on  Split MZC group from command bar: the selected group will be 
removed 
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21 SCHEDULER 

21.1 User interface  
If you click on the  Settings tab from the command bar, then  Scheduler, the 
following window will appear: 

 
 

 

Scheduler window 

 
The Scheduler window controls the scheduled events in order to: 
 

 Set group category (Booking of parking bays) 
 

 Set a value for a MZC group (Reset or Set a specific value) 
 

 Run a UWP 3.0 sequence 
 

 Send commands to displays 

A 

C 

B 
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The Scheduler window includes these sections: 

Section Description 

A Set the Scheduler view:  

 Calendar (default view) 

 List displays a timeline for the selected month.  

 

 

B The Scheduler toolbar contains the buttons for moving to the previous or 
next period, changing the view and settings 

C The Calendar View shows the calendar by day, week, month, or as an 
Event list 
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21.1.1 Scheduler toolbar 
The Scheduler toolbar contains the buttons to manage the events and change the view 
of the calendar. The available tools are as follows: 

 

Command Action  

 
Edit event  

 
Edit series 

 
Delete event 

 
The Restore default state button will reload the schedule from the server. 
If clicked when changes have been made to the schedule, a prompt will 
appear to confirm whether the user wants to reload the schedule and 
discard the changes made. 

 
Moves the current view backwards a year or a week, depending on the 
view selected 

 
Moves the current view backwards a month, week or day, depending on 
the view selected 

 
Moves the current view forwards a month, week or day, depending on the 
view selected 

 
Moves the current view forwards a year or a week, depending on the view 
selected 

 
Centres the view on the current date, displaying the day, week or month, 
depending on the view selected 

 
Changes view of the Schedule to month 

 
Changes view of the Schedule to week 

 
Changes view of the Schedule to day 
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21.2  User interface 

21.2.1 New/Edit event window 
The following window will appear when you create or edit an event: 

 

 

New Event window 

 

The New/Edit event window is divided into 3 parts, as you can create or edit an event to 
perform one or more actions. A scheduled event can be executed once or it can be 
recurrent. 

 

  

A 

C 

B 
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21.2.1.1 Name and time section 

The table below describes the fields of the name and time section as follows: 

Field Description 

Name Defines the name of the event 

Event colour Defines the colour of the event 

Start 

 

Defines the start date and time for the event 

Note: This is disabled if a recurring event 

End 

 

Defines the end date and time for the event 

Note: This is disabled if a recurring event 

All day Check if the event should occur all day 

Repeat the 
activity every 
year 

Check if the event should occur every year at the same time and date 

Recurrence Check if you want to make the event recurring 

 

21.2.1.2 Recurrence section 

The Recurrence section is enabled only if the Recurrence checkbox above is ticked. The fields 
are as follows: 
 

Field Description 

Repeat Defines the frequency with which the event action(s) will be repeated 

Start time Defines the start time for the recurring event action(s) 

End time Defines the end time for the recurring event action(s) 

Repeat Day 

 

Defines the days of the week for the recurring event action(s)  

Note: This is disabled if Every month is selected 

Last day of the 
month 

Check if the event should occur every last day of the month 

Note: This is disabled if Every week is selected 

Start date Defines the start date for the recurring event action(s) 

End date Defines the end date for the recurring event action(s) 
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21.2.1.3 First Activity/Last activity tabs 

In the First activity / Last activity tabs you can define the different actions you want to 
perform according to the scheduled time and date. See the table below: 
 

Field  Description 

Set group 
category 

Set the group category in which the parking bays will be booked, defined as 
follows: 
 

Field  Description 

Group The group containing the bays that will be booked 

Category The category containing the bays that will be 
booked 

Booked Number of bays in the group that will be booked 

Bays Select the single bays that will be booked 

  
Set a value for 
a MZC group 

Set the value for the Master Zone Counter, defined as follows: 
   
 

Field  Description 

MZC group The MZC group that has to be changed  

Command Set the command type, such as Reset or numeric 
value 

Run a 
sequence 

Defines the UWP 3.0 sequence that has to be executed 

Send 
command to 
display 
 

Defines the text that has to be displayed: 
 

Field  Description 

Display The display that will show the text 

Command The text will be shown 
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21.3  Procedures 

21.3.1 Create a new event  
To create a new scheduled event, follow this procedure: 
 

Step Action  

1 Click on any blank area (e.g. a Day box) on the calendar 
grid to create a new event 

2 In the Name box, type a description 

3 Click on the down arrow  next to the Event colour 

4 Select the colour you want from the palette 

 

5 Select date and time for your event, click the date and time 
boxes, and select when your event starts and ends 

 

6 Under the date and time, check the box next to Recurrence  

7 Choose how often you want the event to be repeated, and 
when you want the repeating event to end. See Make an 
existing event repeated for more details 

8 In the Starting action and Ending action tabs set the 
actions you want to manage with the event (see EVENT 
PROCEDURES )  

9 Click Add 

10 When you have finished creating your event, 
click Save from the Scheduler window to store the 
changes 
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21.3.2 Make an existing event repeated 
To make an event recurring, follow this procedure: 

Step Action  

1 Open the Scheduler window  

2 Click the event you want to be recurring  

3 Under the date and time, check the box next to Recurrence.  

In the Recurrence section, choose how often you want the event to be 
repeated, and when you want the repeating event to end. 

4 Choose the drop-down next to the Repeat box to change the recurring event 
to Every week or Every month: 

Frequency Option  

Every week 

 

Select in the Repeat days section the days the event 
will occur: 

 

Note: The day check boxes will only be enabled once 
Every week has been selected 

Every 
month 

Check the optional parameter Last day of the month to 
enable 

 

5 Select in the Start time box the time of day the recurring event will start 

6 Select in the End time box the time of day the recurring event will end 

7 Select in Start date the date the recurring event will start  

8 Select in End date the date the recurring event will end 

Note: the recurrence will run until it is manually removed from the Scheduler 

9 Click Add 

10 When you have finished editing your event, click Save to store the changes 
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IMPORTANT NOTE  
 
If customers check the Repeat the activity every year and/or Recurrence options, they 
MUST set the Start date to 01-01-current year (regardless of the current day) and the 
End date to 31-12-current year.  
 
 

 

Current day 



 

   

                                                

 CPY Server - Manual                        93 

 

 

21.3.3 Make changes to repeating events 
Choose which events in the series you want to update, as a single event or the entire series  

 

To edit only the selected event: to change the options for one event that is part of a series, 
follow this procedure:  
 

Step Action  

1 Open the Scheduler window 

2 Open the event that you want to change, then click on the 

 Edit event button 

3 In the date and time section, change the options, such as 
name, time, that you want to change 

4 In the Recurrence section, change the recurrence options 

5 In the Starting/ending action tabs, change the actions 
that have to be executed 

6 Click on Add  

7 When you have finished editing your event, click Save to 
store the changes 

 

Note: This event will be updated, but the details for all the other recurring events will stay the 
same. 

 

To edit the entire series: to change the options for the entire series, follow this procedure:  
 

Step Action  

1 Open the Scheduler window 

2 Click one of the elements of the series, then click on the  

 Edit series button 

3 In the date and time section, change the options, such as 
name, time, that you want to change 

4 In the Recurrence section, change the recurrence options 

5 In the Starting/ending action tabs, change the actions 
that have to be executed 

6 Click on Add 

7 When you have finished editing your event, click Save to 
store the changes 

 
Note: All events from the past and the future will be updated. 
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21.3.4 EVENT PROCEDURES 
The scheduled event can be used to execute one or more actions at the starting date 
and/or at the ending date. 
 

21.3.4.1 Configure an event to book parking bays 

In the Starting action / Ending action tabs of the New event window you can define the 
action to book parking bays, as follows: 
 

Step Action  

1 Set the date and time for the event (see the Procedures) 

2 Check Set group category to enable the booking action 

3 Choose the drop-down next to Group to select the node (group) of your 
Car Park project 

4 Choose the drop-down next to Category to select the category of your Car 
Park project 

5 Enter the quantity of bays you want to book in the Booked field 

6 Click on Add  

7 When you have finished editing your event, click Save to store the changes 

 

21.3.4.2 Set a value for MZC group 

In the Starting action / Ending action tabs of the New event window you can define the 
action to set a value for a Master Zone Counter, as follows: 
 

Step Action 

1 Set the date and time for the event (Recurrence) (see Make an existing 
event repeated procedure) 

2 Check Set a value for a MZC group  

3 Choose the drop-down next to MZC Group to select the Master Zone 
Counter Group of your Car Park project 

4 Choose the drop-down next to Command to select Reset or Set a value 

5 If the Set a value option is selected, enter the value in the box next to 
Command 

6 Click on Add 

7 When you have finished editing your event, click Save to store the changes 
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21.3.4.3 Run a UWP 3.0 sequence 

In the Starting action / Ending action tabs of the New event window you can select 
which SB2PWEB / UWP 3.0 sequences will be executed according to the scheduler, as 
follows: 
 

Step Action  

1 Set the date and time for the event (Recurrence) (see the Procedures) 

2 Check Run a sequence 

3 In the Sequence field select the sequence to be executed 

4 Click on Add 

5 When you have finished editing your event, click Save to store the changes 

 

21.3.4.4 Send command to display  

 IMPORTANT NOTE: this feature is only for SBPDIS9 display. 

 
In the Starting action / Ending action tabs of the New event window you can select 
which text will be displayed according to the scheduler, as follows: 
 

Step Action  

1 Set the date and time for the event (Recurrence) (see the Procedures) 

2 Check Send command to display  

3 Choose the drop-down next to Display to select the display of your Car 
Park project 

4 Choose the drop-down next to Command to select the command you want 
to be shown 

Note: Special text n refers to the SBPDIS9 display only 

5 Click on Add 

6 When you have finished editing your event, click Save to store the changes 
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21.3.4.5 Delete an event 

To delete a single event, follow this procedure:  

Step Action  

1 Open the Scheduler window 

2 Click on the event you want to delete 

3 Click  

�

21.3.4.6 Delete a series (recurring event) 

To delete a recurring event, follow this procedure:  

Step Action  

1 Open the Scheduler window 

2 Click on an event part of a series: the following window appears: 

3 Delete repetition: delete this event, but keep all the other future events; 

Delete series: delete this event and all the future events; 

�

 

  



 

   

                                                

 CPY Server - Manual                        97 

 

 

22 REMOTE SERVER CONFIGURATION 
 
To manage digital signals provided by the remote server as car park sensors, like the indoor parking 
bays, the installer has to configure the Remote Server connection parameters in the CPY Server. 
The CPY server, using those parameters, will set a connection to the remote server and through 
the API service will collect the occupancy information of all the signals configured and enabled in 
the remote server. 

 

22.1.1 User interface 
In the Remote Server configuration window, the installer can manage the connection 
parameters. This window also shows the expiring dates of the license and the service. 

Remote Server Configuration window 

 

Area Description 

A Sets the Remote Server configuration parameters 

B Buttons to manage the Remote Server configuration and data 

 

  

A

B 
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22.2 Things to know 

22.2.1 Remote Server 
 

The Remote Server functionality uses a proprietary API service to get and collect the 
occupancy information of the digital input signals, in real-time, in the CPY Server. Following 
are the information you get: 

 

 Digital signal status, i.e., the contact status of the signal. 
Vacant = the contact status is OFF 

Occupied = the contact status is ON 

 Diagnostic information of digital signals (such as communication problem, 
hardware issue, and so on.) 

 

22.3 Procedures 

22.3.1 Set the Remote Server configuration 
To configure the CPY server with the parameters of the controller from which the 
information is read through the API web service, follow the procedure below. 

 

Note: ONLY one Remote Server can be managed in a CPY Server configuration. 

 

Step Action 

1 Open the System tab from the navigation bar, then open the Remote Server tab 

2 Enable  the service 

3 Type an identification name in the Connection name field.  

It will be shown on the right panel. 

4 Type the Server address, i.e., the IP address or the DynDNS of the UWP 3.0 Remote 
server with the digital inputs signals you want to manage. It appears as follows: 

https://[UWP 3.0 IP address or DynDNS]/engine 

5 Type the username and password for the API service 

Note: these parameters have to match those set in the UWP 3.0 Remote server API 
service. 

6 Save the changes 
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22.3.2 Check the connection between the Remote Server and 
the CPY Server 

 

To test the API service connection between the Remote Server and the CPY Server, 
follow this procedure: 

Step Action 

1 Open the System tab from the navigation bar, then open the Remote Server tab 

2 Click the Test button to start the test.  

This confirmation message should appear: 

 

If an error appears, check both devices to be connected and the information to be correct. 

 

 

22.3.3 How to check the communication 
 

The installer can see the connection status in the right panel: 

 

Connection status Description 

 

The Remote Server communicates properly with the CPY Server 

 

The Remote Server does not communicate to the CPY Server. You have 
to check the network connection/settings and the API service configuration. 
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22.3.4 Download the Remote Server configuration 
 

After setting the parameters of the UWP 3.0 Remote Server, the installer can download 
the configuration of digital input signals so to add their information to the CPY Server. 
Please follow the procedure below: 

 

Step Action 

1 Open the System tab from the navigation bar, then open the Remote Server tab 

2 Click the Download button.  

The following message appears:  

 

Note: this operation will download a new Remote Server configuration or will update the 
existing one. 

3 Click Yes to download/update the configuration. 

4 Click  to close the Remote Server Configuration window. 

5 Click Yes to update the CPY configuration accordingly. 

  

 

22.3.5 Clean the data of Remote Server Configuration 
To remove the configuration of the Remote Server digital inputs and the relevant historical 
data, follow the procedure below: 

Step Action 

1 Open the System tab from the navigation bar, then open the Remote Server tab. 
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Step Action 

2 Click Clean. 

The following warning message appears: 

 

3 Click Yes to complete the cleaning procedure. 

 

22.3.6 How to check the association between the digital signal 
and the Car Park sensor 

 

The association between the digital signal (configured from the UWP 3.0 Tool) and the 
CPY Server is carried out through ID parameter. The system assigns this parameter to 
each signal automatically (the user cannot change it) and each signal added to the 
configuration it will be shown in the CPY Server with that ID.  

This ID has to be considered during the system planning and configuration in order to 
identify each signal as CPY server sensor easily. 

The below example shows the association of four digital signals of a Smart Dupline® 
module and the relevant sensors in the CPY Server Car Park: 

UWP 3.0 Tool - Car park digital window CPY Server - Drawing 

  

 

Video Click here to see the video of this procedure. 
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23 DRAWING 

23.1 User interface 
The drawings window gives you a real complete overview of the layout of the Car Park 
installation and shows the current status of the parking bays included in the drawing.  
 

 

 

A Drawing window 

 
 
The image above shows an example of a drawing: each icon (a small car) represents a 
parking space (in this manual it is referred to as a bay). The colouring/pattern of each 
bay is an indication of the bay sensor's status and its category. These properties can be 
defined in the Status/categories setup of this manual. This information tells you what the 
real-time status of each of them is. 
 
You can create a drawing for each floor of your Car Park project; the different drawings 
are shown by clicking on the related node (group) on the left panel of the CPY Web 
Server, or you can define a Layout in order to display all the drawings at a glance in the 
dashboard area. 
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23.1.1 Drawing window 

If you click on the  Drawings tab from the navigation bar, then Add Drawing, the 
following window will appear: 

 

 

Drawing window in edit mode 

 

The Edit Drawing window includes 3 sections: 

Section Description 

A The Drawing toolbar offers all the tools for Drawing and Category 
assignment 

B The list shows Sensor and Displays and Indicators tabs available for 
the selected node (group) 

C The Canvas area includes all the graphical items such as background 
image, bay icons and displays. The area can be panned (scrolled 
left/right and up/down) and zoomed 

 

  

A 

C 

B 
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23.1.1.1 Drawing toolbar 

The Drawing toolbar offers several tools for selecting, drawing, or modifying the bay and 
display properties. The available tools are as follows: 

Command Action  

 
Edit drawing  

 
Save drawing 

 
Delete drawing 

 
Settings 

 
Selection (works as a toggle): click to select and click again to 
deselect. It can be used to activate drag handles 

 
Zooming 

 /  
Assisted Drawing / Free hand drawing 

Works as a toggle: click to select the Free hand drawing and click 
again to select Assisted drawing mode 

 
Display settings 

 
Edit position for selected bays 

 
Vertical alignment 

 
Horizontal alignment 

 
Delete 

 
Works as a toggle: show/hide lane, line, position information for 
each bay 

 
Shows the bays that belong to an Indicator 

 Quick booking activity for selected bays 
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23.1.1.2 Draw settings 

The Settings are accessed by clicking the  button in the Drawing toolbar: 
 

 

 
In this dialog, you can configure the drawing's name, the size of the bay icons in the 
drawing and decide how the drawing's background image is displayed. When a field is 
updated, the changes can immediately be seen on the drawing. The dialog has the 
following fields: 
 

Section Field description 

A Name 

Can be used to modify the name of the drawing 
 

Icon size 

Sets the size of the bay icon representing parking bay sensors. The 
number represents the length in pixels. This option is useful when making 
your bay icons match the scale of your background image 
 

B Colour 

Shows a colour-picker dialog that selects the colour that will be seen 
behind the background image 
 

Image 

Upload a background image 
 

A 

B 
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Section Field description 

Image position offset (X, Y) 

First field: this field contains the horizontal offset of the background image. 
The offset is measured in pixels. The higher the offset, the further the 
image moves to the right 

Second field:  this field contains the vertical offset of the background 
image. The offset is measured in pixels. The higher the offset, the further 
the image moves down 
 

Image zoom 

This field scales the background image size up or down, depending on 
whether the number entered is above or below 100. The number in the 
field represents the percentage of the image's original size that you want 
it to be scaled to 
 

Image opacity 

This sets the opacity of the background image. It is possible to set an 
opacity between 0% and 100%.  The lower the opacity, the more 
transparent the background image will become and the more the 
selected Colour will be seen 
 

 

23.2  Procedures 

23.2.1 Upload a background image 
You can put a background image in your drawing window. This is not interactive but serves to put 
the bay icons location in perspective. Follow this procedure: 
 
 

Step Action 

1 
Click on  Draw settings from the Drawing menu 

Note: this is accessible only in Edit mode 

2 In the Image section, click the Browse button: 

a standard Windows browse interface will appear 

3 Locate and highlight the background image from your computer  

Note: The supported file formats are JPG and PNG 

NOTICE: MAXIMUM FILE SIZE 2 MB 

4 Click on Open, then on the Upload button 

5 The background image will also be uploaded onto the canvas area 
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23.2.2 Delete a background image 
To delete a background image that has been uploaded in a drawing, follow this procedure: 
 

Step Action 

1 
Click on  Draw settings from the Drawing menu 

Note: this is accessible only in Edit mode 

2 In the Image section, click the Clear button: 

The drawing's current background image will be deleted 

 

23.2.3 Apply an offset Image position  
Follow this procedure to apply an offset to the background image: 

 

 
 
 
The changes made are not permanent until the OK button is pressed. If you are not 
satisfied with the changes, simply press Cancel and the changes will be reversed after 
closing the drawing. 
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23.2.4 Manage the image opacity 
The opacity property specifies the transparency of the background image. This property 
can take a value from 0 (%) to 100(%). The lower the value, the more transparent the 
image is. 
 
The picture below shows the original background image (100%) and the opacity set to 50% 
 

 

 
The changes made are not permanent until the OK button is pressed. If you are not 
satisfied with the changes, simply press Cancel and the changes will be reversed after 
closing the drawing.  
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23.3  User interface 

23.3.1 Positioning 

You can open the Positioning dialog by clicking on  in the Drawing toolbar. 
 
This dialog is used to define the placement of the sensors relative to each other, as well as to the 
rest of the drawing. Adjustments made here can instantly be seen on the drawing. The dialog has 
the following sections: 
 

 
 
The dialog has the following fields: 
 

Section Field description 

A The Start position defines the collection of the positions of the bays icons 
on the drawing. The initial values are the positions where the bay icons were 
placed 

Field Action 

X 
The horizontal offset of the collection. The greater the 
number, the further left on the drawing the collection is 
moved 

Y 
The vertical offset of the collection. The greater the number, 
the further down on the drawing the collection is moved 
 

 

The Spacing arrows increase/decrease the space between the bay icons on 
their respective axes. 

Field Action 

X 
Arrows increase/decrease spacing between sensors on the 
horizontal axis. 
 

Y 
Arrows increase/decrease spacing between sensors on the 
vertical axis 
 

 

A 

B 
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Section Field description 

The Alignment Flip orientation check box: enabling this will swap the 
number of bay icons spread across the vertical axis with the number of bay 
icons spread across the horizontal axis. 

B 
Degrees (0° – 360°): The position of a selected Sensor line can be 
adjusted by angle in degrees 
 

23.4  Things to know 

23.4.1 Selecting spaces 
The bay selection can be performed in both View mode and Edit mode in a Drawing. 
You are in edit mode when the edit button is pressed on a Drawing, otherwise you are in view 
mode. The actions available are as follows: 
 

Mode Actions 

View mode  Change categories 

 Perform selection 

Edit mode  Move bays in the canvas area 

 Select group of bays to edit spacing 

 Select group of bays to apply graphical properties 
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23.5  Procedures 
Follow the proper procedure to make a selection: 

23.5.1 Select a single bay 
To select a single bay icon, click on it: 
 
You will know a bay icon has been selected when a box appears around it 
 

View mode Edit mode 

 
 

A light-blue box appears around the 
selected bay 

A light-blue box with the drag point 
appears around the selected bay 

 
Note: to deselect the bay, click on a blank part of the drawing  
 

23.5.2 Select multiple bays 
To select multiple bays, follow this procedure: 

Step Action 

1 Select the Drawing with the bay icons you want to select 

2 Put the mouse pointer near the first bay icon 

3 
a. Click and hold your left mouse button on the top left portion of where you want to start 

highlighting 
 

 
 

b. Drag the box until the last bay icon has been highlighted 
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Note: to deselect the bay, click on a blank part of the drawing  
  

Step Action 

  
 
c. Release the left mouse button 

 

4 Once the bay icons have been selected, they can be booked, moved, dragged to another 
canvas area or deleted  

The pictures below shown the selection according to the Drawing mode 

 

              EDIT MODE                                                        VIEW MODE                                    
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23.5.3 Add new drawing 
To add a new blank drawing, follow this procedure: 
 
 

Step Action 

1 
Select a group from the Groups panel (see below) 

  
 
Note: you have to select a node (group), otherwise the Drawing window that will be 
shown will be blank (no Sensor, Displays or Indicators)  
 

2 
In the Drawings tab, click Add Drawing button to open a new blank drawing 

3 
Click on the  Edit button from the command bar to enter into Edit mode 

  

4 
Click on the Settings button, where the drawing settings will appear: 

Enter the desired name for the drawing. Follow the procedures in Drawing chapter 

5 Click OK to save the changes, or Cancel to exit without saving any changes 
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23.5.4 Edit a Drawing 
To access a Drawing in edit mode, follow this procedure: 
 

Step Action 

1 
Click on the   Edit button from the Drawing toolbar 

 

2 
The extra button will be shown in the Drawing toolbar 

 

3 Click on the  Save button to save the changes.  
 
Note: the edit button works as a toggle: click to enter into Edit mode and click again to 
go back to View mode, without saving the changes.  
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23.6  Things to know 

23.6.1 Sensors Line 
Before drawing a Sensor line, you have to select the node (group) which includes the sensor line 
you need to draw. After you have added a new blank drawing, all the sensor lines available for the 
selected group are shown in the menu on the left. 
 

23.7 Procedures 

23.7.1 Add a line in the drawing 
In order to add a sensor LINE onto the canvas, follow this procedure: 

Note: You can drag only one sensor LINE at a time 

Step Action 

1 Add new drawing 

2 From the Sensors tab in the left panel, click on a Sensor line 

 

Note: The selected Sensor line will be highlighted in light blue 

3 Once you have made your selection, position the mouse pointer onto the canvas area of 
your drawing 

4 
a. Hold the left mouse button down on the point where you want to start dragging 
 
b. Drag the Sensor Line to the point where you want to finish.  
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Step Action 

 
 
c. Release the left mouse button 

 

5 

The bay sensors will be added: see the picture below 

 

 
 

6 

The sensors added remain selected: you can move them onto the canvas area, adjust 

the spacing by clicking the  Edit position for selected spaces button, or deleted by 

clicking the  Delete button 

Hold down Release 
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23.7.2 Assisted / Freehand drawing 
A Sensor line can be dragged in two modes, Assisted mode or in Freehand mode, as follows: 
 

Step Action 

1 

By default, the  Assisted Drawing option is selected: The Line can be dragged 
vertically or horizontally. 

 

 

2 By clicking on the  Assisted Drawing button, the drawing mode turns into the  
Freehand drawing mode: you can drag a Sensor Line at any angle 
 

 
 

 

23.7.3 Move the bay icons in the drawing 
Follow this procedure to move one or more bay icons into the drawing window: 

Step Action 

1 In Drawing Edit mode, click on one or more of the bay icons you wish to move 

2 Hold the left mouse button down 

3 Move the mouse cursor to the desired location 

4 Release the left mouse button 

Hold down Release 
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23.7.4 Alignment operations 
 
If you have several unorganized bay icons you wish to align, you can do so with the  

 Vertical alignment and  Horizontal alignment buttons in the Drawing toolbar. 
 

23.7.4.1 Horizontal alignment 

This button will align all the selected bay icons in a horizontal line, as seen below: 
 

Step Action 

1 Select the bay icons 

  

2 Click on the   Horizontal alignment button 
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23.7.4.2 Vertical alignment 

This button will align all the selected bay icons in a vertical line, as seen below: 

Step Action 

3 

 

Step Action 

1 

 

2 Select the bay icons 

 

3 Click on the   Vertical alignment button 
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Step Action 
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23.7.5 Delete a bay 
To delete bay icons, follow this procedure: 

Step Action 

1 Select the bay icons 

 

2 Press the  Delete button 

 

3 Press the Yes button for confirmation  
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23.7.6 Delete a drawing 
To delete a drawing from the Drawings menu and the system as a whole, follow this procedure: 
 

  

Step Action 

1 Open a Drawing window by clicking on the selected node from the Groups panel on the 
left side 

2 Once you have made your selection, click on the Edit button on the drawing you want to 
delete in order to show the extra button 

3 Click on the  Delete drawing button 

4 Click on OK to confirm the operation, otherwise click on Cancel to annul the operation 
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23.8 User interface 

23.8.1 Displays 
The displays can be used to present an overview of the parking lot in real-time. The picture below 
shows a Drawing window of a Car Park project where three displays are used to present the 
occupancy status of a floor with Total bays, Vacant bays and Total occupied bays statuses. 
 

 

 

Displays on a Drawing window 

 

23.9 Things to know 

23.9.1 Real display and virtual display 
The displays that can be added in a Drawing, also called Software display, can be of two 
types: 

 

Type Description 

Real display A software version of a real display. 

Note: See the Hardware manual for additional information about Display 
model and installation instructions. 

Virtual display A Virtual display created by the user 
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Each software display can be configured in terms of: 

 
 Appearance: both display types can be proportionally resizable; the label, the colour of 

digits, etc… 

 Value: the numeric value can be assigned to the software display, which is updated in real 
time with the software value. For the Virtual type, it has to be linked to a group of sensors 
and one category 

 

23.9.2 Software display settings 

By clicking on the  Display settings button, the following window appears: 

Note: The Display settings window is accessible only in Drawing edit mode. 

 
 

 

Display settings window 

The Display settings window is defined as follows: 

Section Description 

A The Displays section shows the list of displays available in terms of Real 
display and Virtual display 

B Display configuration window  

Note: Only for Real displays  

A 
C 

B 

D 
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Section Description 

C The elements list of the Display settings window: 
 

Field  Description 

Label Enter text that describes the display: the text will be shown in 
the position defined in the Label position field 

Label position Defines the position where the text Label will be shown 

Label font Defines the label font, size and colour 

No. of digits No. of digits to display value 

Note: cannot be changed for real display 

Offset Sets an offset (it can be positive or negative) to the real value 

Max value to show Sets the maximum value that will be shown 

IMPORTANT NOTE: you MUST set this field. Otherwise, the 
default value (0) is set and the Display will not count properly. 

Category Select from the categories defined in the Car Park project 

Value type 

 

Choose between the following: 

 number of Vacant bays 

 number of Occupied bays 

 Total number of bays 

Group Select the group to represent the value in the display 

Value font Defines the Value font, size and colour 

Left icon For real displays: shows the real display icon (when 
available) 

For virtual displays: shows the available icon you can use 
for the left side of the display 

Right icon For real displays: shows the real display icon (when 
available) 

For virtual displays: shows the available icon you can use 
for the right side of the display 

Width Defines the width of the software display (in pixels) 

Height Defines the height of the software display (in pixels) 

Border width Specifies width of display border (in pixels) 

Background colour Assigns a background colour to the software display 

Border colour Defines the border colour of the software display 
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Section Description 

D The preview area shows a preview simulation of the software display 

 

23.9.3 Virtual and Real Displays 
A Virtual display is fully customizable since all the fields are changeable. 

As concerns the software copy of a Real display, you can customize the appearance, the 
group and category of bays have to be shown. However, you cannot change the fields 
related to the Physical part number, such as those seen in the orange boxes below: 

 

 Part number 

 No. of digits 

 Left icon 

 Right icon 
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23.10 Procedures 
The Displays tab shows all the Real Displays present in the Car Park project; you can add 
them to a Drawing as a software copy of the real display. 

The Displays tab also presents Virtual displays that have been created in the Car Park 
project: The Virtual types are shown with a small icon in the top-right corner, as shown 
in the example below: 

 

 

23.10.1 Add a Display from the Displays tab 
Follow this procedure to add a display in a drawing: 

Step Action 

1 Open the Drawing window where you want to add a display 

2 
Click on   Edit from the Drawing toolbar 

3 Click on the Displays tab from the Left Panel 

4 From the Displays, click on the text of the selected display 

 

Note: The selected display will be highlighted in light blue  

5 Click the left mouse button on the area where you want to put the software display 
element 
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23.10.2 Edit a Software display (associated to a Real Display)  
A software display can be edited by clicking on the Display settings window from the Drawing 
toolbar. Follow this procedure: 

Step Action 

 

6 

The display will be added to the drawing 

 
 

You can edit the software display by clicking on the  Display configuration button. 
See the Edit a Software display (associated to a Real Display) procedure 
 

Step Action 

1 Add a Display from the Displays tab 

2 Click the software display with the left mouse button to select it: 

 

Note: a light-blue box with the drag point appears around the selected display   

3 Click on the  Display settings button from the command bar: The Display settings will 
appear 
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23.10.3 Create a new Virtual display 

Step Action 

4 
Edit all the fields required (see Software display settings table) 

Note: you can click on the Preview button to see the appearance 

5 Click on the Display configuration button for additional settings 

6 Click on the Save button to store the changes. 

Step Action 

1 Open a Drawing window in edit mode 

2 Click with the left mouse button in a blank area of the background where the display will 
be 

 

Note: a light-blue box with the drag point appears around the selected display   

3 Click on the  Display settings button from the command bar: The Display settings will 
appear 

4 
Edit all the fields required (see the table for detailed information) 
 
Note: you can click on the Preview button to see the appearance 

5 For the Virtual display, the Display configuration button is not clickable 

6 

Click on the Save button to store the changes. See the example below: 
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23.10.4 Delete a Display 
To delete a display from the Car Park project, follow this procedure:  
 

 
  

Step Action 

1 Open Drawing in edit mode 

2 Select the display you want to delete 

 

Note: the display will be highlighted with a light blue rectangle 

3 Click on the  Delete button and click on Save drawing to delete it from the drawing 
and the Displays tab. 
 

 
 
Note: if you exit without clicking on Save, the Display will not be deleted 
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23.10.5 Display configuration and commands  

23.10.5.1  Digits display with left/right icons 

The Display configuration button opens the real configuration window, in which you can 
configure the following parameters. 

Note: This window is available ONLY for the Software copy of the Real Display.  

Please refer to the UWP 3.0 Tool for the protocol for System configuration. 
 

 

 

Display configuration window 

 
The Display configuration window includes these sections: 
 

Section Description 

A In the Display configuration section, you can configure the 
appearance and behaviour of the display elements. 

B In the Display commands section, you can perform system checks. 

 
 
  

A 

B 
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23.10.5.2 Display configuration 

The fields are shown according to the Display Part number, as defined as follows: 

23.10.5.3 Display commands 

 

  

Field  Description 

Arrow operation mode 
Defines the arrow condition in operation mode: 

 Static 

 Moving 

Note: this field is available ONLY for display module with arrow 

Arrow direction 
Defines the arrow orientation (if available) 

Note: this field is available ONLY for display module with arrow 

Show 0 when full 
The display shows 0 in FULL situation (Hide, Show) 

Show the red X  
when full The display shows red X in FULL situation (Hide, Show) 

Display arrow when full 
The display shows the arrow in FULL situation (Hide, Show) 

Note: this field is available ONLY for display module with arrow 

Brightness control The brightness of the real display can be set to: 

 30% 

 50% 

 75% 

 Automatic: the brightness is automatically adjusted according to the 
internal lux-sensor 

Field  Description 

Switch all LEDs ON Sends special values to switch all the LEDs ON 

Switch all LEDs OFF Sends special values to switch all the LEDs OFF 

Show number Shows the number set in the box above the Show number field 



 

   

                                                

 CPY Server - Manual                        133 

 

 

23.11 Procedures 

23.11.1 Configure digits display with left/right icons 
To configure a digits display with left/right icons, follow this procedure: 

 

23.11.2 Send command to a display 
To send a command to a real display, follow this procedure: 

Step Action 

1 Enter Drawing in edit mode 

2 Select a digits display module from the Displays tab 

Note: The selected display will be highlighted in light blue  

3 Click on the Display configuration button from the Display settings window 

4 Configure the display properties in the Display configuration section 

5 Click on the Submit button to save the changes 

Step Action 

1 Enter Drawing in edit mode 

2 Select a display module from the Displays tab, or select it from a Drawing window 
where it is. 

Note: The selected display will be highlighted in light blue  

3 Click on the Display configuration button from the Display settings window 

4 In the Display command section, click on the command you need in order to perform the 
test. The following message will appear to confirm the command has been sent 
successfully: 

  

5 Click on the Submit button to save the changes 

6 
Note: When a command is sent to a display, a small red dot icon will appear in the Drawing 
window (see the picture below). It will remain so as long as the command is active  
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23.11.3 Display configuration and commands  

23.11.3.1 Alphanumeric display with 9 characters (SBPDIS9x module)  

By clicking on the Display configuration button, the following window appears: 
 

 

Display configuration window 

 
The Display configuration window includes these sections: 
 

Section Description 

A In the Display configuration section, you can configure the 
appearance and behaviour of the display elements. 

Note: the field changes according to the Display part number 

B In the Display commands section, you can perform system checks. 

Note: the available button changes according to the Display part number 

 

 

 

7 
Click again the command button sent before deactivating: the small red dot icon 
will disappear 

A 

B 
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23.11.3.2 Display configuration 

 

23.11.3.3 Display commands 

 
 
  

Field  Description 

Characters 
configuration 
if not full 

Defines the text to show in not full condition: 

 Text Only, up to 9 characters (AAAAAAAAA) 

 6 characters and 3 digits (AAAAAAxxx) 

 5 characters and 4 digits (AAAAAxxxx) 

 4 characters and 5 digits (AAAAAxxxx) 

Text to display 
Enter the text to display for not full condition (number of characters, number 
of digits) according to the field above 

Characters 
configuration 
if full 

Defines the text to show in not full condition: 

 Text Only, up to 9 characters (AAAAAAAAA) 

 6 characters and 3 digits (AAAAAAxxx) 

 5 characters and 4 digits (AAAAAxxxx) 

 4 characters and 5 digits (AAAAAxxxx) 

Text to display 
Enter the text to display for full condition (number of characters, number of 
digits) according to the field above 

Special text 1 

Defines the Special text to display: these Special texts can be shown with the 
Scheduler events 

Special text 2 

Special text 3 

Field  Description 

Show special 
text 1 Send special values to show the text strings defined in the section above: 

 Special text 1 

 Special text 2 

 Special text 3 

 

Show special 
text 2 

Show special 
text 3 
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23.11.4 Configure alphanumeric display SBPDIS9x 
To configure the SBPDIS9 module with 9 alphanumeric digits, follow this procedure: 

 

23.11.5 Send command to show a special text 
To send a command to show a special text, follow this procedure: 

 

Step Action 

1 Enter Drawing edit mode 

2 Select a SBPDIS9 display module from the Displays tab 

Note: The selected display will be highlighted in light blue  

3 Click on the Display configuration button from the Display settings window 

4 Configure the display properties in the Display configuration section 

5 Click on the Submit button to save the changes 

Step Action 

1 Enter Drawing in edit mode 

2 Select a display module from the Displays tab, or select it from a Drawing window 
where it is. 

Note: The selected display will be highlighted in light blue  

3 Click on the Display configuration button from the Display settings window 

4 In the Display command section, click on the Show special text field you want to show.  
The following message will appear to confirm the command has been sent successfully: 

  

5 Click on the Submit button to save the changes 

6 
Note: When a command is sent to a display, a small red dot icon will appear in the 
Drawing window. It will remain so as long as the command is active  

7 
Click again the command button sent before deactivating: the message will be removed 
from the display 
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23.11.6 Remove a display from a Drawing  
Follow this procedure to remove the software copy of a Real Display from a drawing:  the display 
cannot be deleted by the Displays tab (SBP2CPY project): 
 

 
  

Step Action 

1 Open Drawing in edit mode 

2 Select the Real display you want to delete 

 

Note: the display will be highlighted with a light blue rectangle 

3 Click on the  Delete button and click on  Save drawing to delete. 
 
Note: you can add it again from the Displays tab as a new software copy 
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23.12 User interface 

23.12.1 Indicators 
The SBPILED is an 8-colour LED indicator and it is part of the Dupline® 3 Parking 
Guidance System. It can be mounted outside the parking bays along the driving lane and 
it is used to indicate the status (e.g. vacant, occupied,) of a group of bays. A dedicated 
function is available in the UWP 3.0 Tool in order to define which bays have to be 
represented by an Indicator.   
 
Please refer to the UWP 3.0 Tool manual for further details about configuration. 
 
The following table shows the behaviour of the SBPILED Indicator: 
 

Bays SBPILED Indicator 

At least one bay 
is vacant 

The SBPILED LED is lit up in the default colour of the category 
of the bays. 

All the bays are 
occupied 

The SBPILED LED is lit up in RED (default colour for Occupied 
status)  

23.13 Things to know 
 
Each bay can be associated to an Indicator means the dedicated function. The picture 
below shows a Drawing window of a Car Park project where 6 bays are set in the 
Reserved category (orange colour), managed by an Indicator. 
 

 

 

Software Indicator on a Drawing window 
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23.13.1 Example 
 

The example below shows a group of 6 bays set as Reserved category.  
When at least one of the bays is vacant, the SBPILED is lit up in orange (default colour 
for Reserved category).  
 

Group bays status SBPILED status 
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23.14 Procedures 

23.14.1 Verify which bays belong to an Indicator 
Follow this procedure to change the category of the bays associated to an Indicator: the 
category value is assigned to all the bays which belong to the indicator. In the command 
bar there is a button to show which bays belong to an Indicator: follow this procedure to 
check: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Step  Action 

1  

Enter Drawing in edit mode and Click on the  button from the 
toolbar: 
 

 
 

2  
The bays that belong to an indicator are identified by a coloured 
rectangle box: 
 

 
 
Note: if several Indicators are present, each group of bays that 
belong to the same indicator are shown with the same colour 
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23.14.2 Change the category of the bays associated to an 
Indicator  

Follow this procedure to change the category of the bays associated to an Indicator: the 
category value is assigned to all the bays which belong the indicator: 
 

Step  Action 

1 Select a bay that is part of the group Indicator and click on the flag 
of the desired category (e.g. Normal category): 
 

 
 

2 If one or more bays selected are associated to an Indicator, the following 
message appears: 
 

 
3 Click Yes button to change the category for all the bays 

 
4 A dialog message shows the detailed operation 
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Step  Action 

 
 

5 The example below shows the result, the 3 bays shown in the red 
rectangle are booked as Normal category 
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23.15 Operations with the drawings 

23.15.1 Zooming the drawing 
 

 
 
 
The drawing interface has three zoom options: 
 

 
 
 
 
 
 
 
 
 
 
 

Command  Action 

 
Zoom in  
Enlarges the drawing 

 
Zoom to fit 
Resizes the drawing to fit the current window size 

 
Zoom out 
Shrinks the drawing 
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23.15.2 Change the categories (booking and unbooking) bays 
In the command bar there are the buttons related to the available categories of the Car 
Park project. You can enable up to 7 different categories: please refer to the 
Categories/Status menu 
 

 
 
Follow this procedure to change the category of one or more bays: 
 
The type of light used for a booking is indicated on the drawing as illustrated below: 

Step  Action 

1 If one or more bay icons are selected when the button is clicked, these 
bays will become booked with their category 
 

2 Select one or more bays 

 
 
E.g. change the category for the 4 bays in the red rectangle below from 
Normal to Reserved category 

3 Click on the flag of the desired category (e.g. Reserved category) 
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Step  Action 

 
 
On the Change spaces category dialog, click Yes button 

4 A dialog message shows the detailed operation 
 

 
 

5 The example below shows the booking result, the 4 bays shown in the 
red rectangle are booked as Reserved category 
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23.15.2.1 Change the category of mixed groups of bays associated or not 
to indicators 

The example below shows a drawing with a group of bays that belong to an Indicator 
together with single sensor bays. If the selected bays are associated to different 
indicators or not all the bays are associated to one indicator, a message is displayed with 
different options, as described below: 
 

Step Action 

1 
 
In the example shown below the selected bays in orange colour belong to an 
indicator, while the selected bays in green color do not belong to any indicator. 
 

 
 

2 
 
Click on a flag to change the category, the following message is displayed: 
This message is shown whenever the selected bays are associated to different 
indicators or not all the bays associated to one indicator have been selected:  
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Step Action 

3 
Click on option A to change the category ONLY for the bays that belong to an 
Indicator: Only the select left bays will be booked with the new category: 
 

                

4 
 
Click on option B to change the category for BOTH the bays that belong to an 
Indicator and the bays that are not associated to any indicator: 
 

                

5 Clicking on option C to change the category ONLY for the bays that are not 
associated to any Indicator; the category will not be changed for the bays that 
belong to an Indicator: 
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23.15.3 Create a new event directly from a drawing 
In the command bar you can create a quick booking activity directly from the drawing, for 
the selected bays. Follow this procedure to add a new booking activity for one or more 
bays: 

 
 
 

Step  Action 

1  
Enter Drawing in view mode and select the bays want to create a 
booking activity: 
 

 

2  
Click on the  button from the command bar: 
 

 
 

3 The New event window is opened with the selected bays automatically 
set in the Bay field: 
 

 
 
Note: you can add/remove additional bays different that the selected 
ones, clicking on the small v icon on Bays field. 
 

4 See Create a new event procedures to create the new booking 
activity. 
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23.15.4 Tooltip overview (bay icon) 
By hovering over a bay icon with the mouse, the tooltip dialog appears with the bay sensor 
information such as:  
 
          

          
 
 

          
 
 

 IMPORTANT NOTE! 
Remember that when you send the configuration to the controller or when you reboot the 
controller, the time period for either empty or occupied status of the sensor in Bay Icon will reset 
and starts to count again.  
 

 
Before sending the configuration   After sending the configuration 

to the controller    to the controller 
 
 
 

23.15.5 Tooltip overview (Display) 
By hovering over a Display with the mouse, the tooltip dialog appears with the Display information 
such as:  
 
 

 
 

Bay Icon 
 

 Kxx - Sensor Part Number - Lane Line Position 
 

 Empty /Occupied: how long the bay is empty or 
occupied 

 
 Indicator: (only for bays that belong to an 

Indicator) show the related Indicator 
 

 Diagnostic info: e.g., error condition, Cross Talk 

Display Icon 
 

 Kxx - Display Part Number 
 

 Disconnect time: how long the display is 
disconnected 

 
 Diagnostic info: e.g. Hardware error 
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24 LAYOUTS 

24.1 User Interface 
Layout describes the positioning of the constituent parts, such as the Drawing and 
Status windows, on the dashboard area. See the highlighted area below: 
 

 
 
By using the Layout, you can create different views of your parking lot in order to see the 
occupancy status, depending on the selected node, and considering the size of the 
parking lot. 
 

24.2 Things to know 

24.2.1 The Basics of Layout 
A Layout can be created for a tree node, optimized for a device or for a specific user.  
The Layout is a combination of three conditions: 

 
 Client-PC (browser): the CPY runs as a webserver in a browser: it could be that 

the Layout must be created according to the screen size of the PC or the number 
of screens if a multiple screen solution is used.  

 
 User: you can create several Layouts and assign each one to a dedicated user. 

 
 

 Rules: A rule defines how to arrange the elements on the screen when a node is 
selected. There are different level priorities which help you to define the best view 
for each level node. 
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24.2.2 Single screen or Multi screen 
The most important choice is the type of Device, Single screen or Multi screen. This 
depends on the size of the parking lot (number of floors, or number of parking bays). 
 

Device type Indications 

Single screen 

 

If you have to manage a small parking lot with 3 floors, you can 
optimize the Layout on a single screen. You can adjust the 
zoom factor of the browser to obtain the best distribution of 
your elements 
 

Multi-screen 

 

This solution is suggested for a large parking lot, for example 
where thousands of parking bays are distributed on several 
floors.  
 

Note: when the Multi screen Device is selected, all the screens 
must have the same screen resolution and screen size, also 
the browser. 

 
The Layout must be designed using the same screen configuration as that used by the 
operator: 
When the SB2CPY is started, the system reads the Layout set for the user and places the 
elements exactly as they are defined during the Layout editing.  
 
N.B: A Layout created for a Multi-screen device may not work correctly for a Single 
screen, also vice versa. 
 

24.2.3 User and Layout assignment 

To assign a template to a specific user, the user account has to be edited. There is a field 
in the Accounts window labelled Layout where you can set the specific Layout from the 
combo-box. 

 
 
 
Note: When a user logs into the CPY webserver, the system loads the Layout assigned: if 
the Layout does not exist (e.g. the Layout has been deleted), the default Layout system is 
applied. 
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24.2.4 Rules 
The Layout is the set of rules that lays out the view of all the tree nodes, representing a 
particular group of the parking lot. See the example below of the node hierarchy of a 
project. 
 

 
 
 
Each one is a node: the children of the root (highlighted in orange) are nodes at the same 
level, as well as their children (the nodes highlighted in yellow are at the same level).  
 

24.2.4.1 Priority order of rules 

When you select a tree node, the system checks if a rule for the selected node exists, 
then checks if a rule for that level exists, then checks if a rule for all nodes exists. If not, 
no windows are displayed. 
 
The rules have to be applied to the node: the system asks you where you want to apply 
them: 
 
 

Priority level Node type 

Highest priority Node 
A rule applied to a specific node has the highest priority: the other 
rules applied to the level’s node will be ignored. 

 

 Level 

 

 

Lower priority 

All nodes 

 

 
 
 
 
 

In the figure on the left, the parent-child 
relationship within the tree is as follows: 
 
TOWER1 is the root and parent of Roof, Floor1 
and Floor2. 
 
MZC5.1 and Roof Bays are the children of Roof;  
 
Disabled_bays is the child of Floor2; 
 
Floor1 has no child 
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24.2.4.2 Priority example 

The following example explains how the rules work, in particular how the nodes priority 
works.  

By clicking on a floor level node (e.g. Floor1, Floor2, Roof) you can choose a different 
view, for example to display the drawing and status window for each of them.  

 

All nodes priority 

You can start from the lower level, in order to apply the rule with the lower priority: 

When All nodes rule is applied, this ensures that any existing rule defined for Current level 
or Current node will not be overridden.  

By clicking on one of the children of the floors (MZC5.1, RoofBays or Disabled_bays) 
the rule will be applied for all nodes, for example if you want to place the drawing window 
in the centre of the screen. See the figure below: 
 

 
 
 
  
 
 
 
 
 
 
 
 
 
N.B: when All nodes is selected, the same rule will be applied for all the nodes. 
  

 

Drawing  
window 
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Current level priority 
You can set the Current level rule in order to assign the same Layout to all the nodes at 
the same level: the priority is higher than All Nodes, so the level rule will be applied to all 
the floor levels. By clicking one of the floors level node (e.g. Floor1, Floor2, Roof) the rule 
will be applied for all nodes at the same level, in this case Floor1, Floor2 and Roof. For 
example, if you want to place the drawing and status window together in the screen. See 
the figure below: 
 

   
 
 
 
  
  
 
 
 
 
 
 
 
 
Tips: Applying this rule will avoid having to adjust the view for each tree node: the rule 
will be propagated to all the nodes at the same level. 
 
Current node priority 
The Current node rule can be used when you want to assign a view for a selected node. 
By clicking on the root node (e.g. TOWER1) the rule will be applied only for the node 
selected, and will override any existing rule created at level node or all nodes. In this 
case, you can choose to display all the drawings of your parking lot when TOWER1 node 
is selected. See the figure below: 
 

 
 
 
  
 
 
 
 
 
 
 
 
 

 

Roof 
drawing 

 

Second floor 
drawing 

 

Status  
window 

 

First floor  
drawing 

 

 

 

 

Roof 
drawing 

 

 

 

 

Status  
window 
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24.3 User interface 

24.3.1 Rule setting window 
In the Rules setting window you have to define the rule priority every time a node is 
edited. The priority has to be set individually, according to the indications explained 
above.  
 
By clicking on Save rule from the Layout tab, the following window will appear: 
 

 
 
The behaviour of the different options works as follows: 
 

Rule Behaviour 

Current node The rule will be applied only for the selected node 

Current Level The rule will be applied to all the nodes at the same level  
(e.g. Root, Floor1and Floor2) 

Note: the system applies the same rule for all the levels, also 
if new nodes are added later 

All Nodes The rule will be applied to all the nodes in the project. 

 

Override option Priority type 

Override other rules When this option is checked, any old rules created in the past 
will be deleted and replaced with the new ones. 
 
Current Level: If you select “override other rules”, the rule 
will be applied to the node selected in the tree and every 
other rule for that node will be ignored 
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24.4 Procedures 

24.4.1 Create a new Layout  
Before starting with Layout editing, the drawings must be already done (see 
Drawing). 
 
To create a new Layout, follow this procedure: 
 

Step Action 

1 Click on the Edit layout tab from Layout tab 

2 Click on New layout in the Layout settings window 

 

3 Select the type of Device that the current Layout is associated to: 

 Single monitor 

 Multi monitor 

Note: see Single screen or Multi screen 

4 Enter a description in the Layout name field 

5 Click OK button to close the window. Now you are in edit layout mode 

6 Choose an element from the Groups tree, such as a node in which there is one 
or more Drawings you want to rearrange (e.g. adjust their sizes)  

e.g. By clicking on TOWER1, the drawing for the sub-nodes, such as Floor1, 
Floor2, Roof, will be shown.  
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Step Action 

7 For each element (such as Drawing or Status window) you want to add: 

a. Click and drag across the dashboard area to form a square or rectangle 

b. Resize element by clicking on a border and dragging it to a new position  

c. Move the element by clicking and dragging. 

 

8 When you are ready to apply changes to your elements, click on Save rules 
from the Layout tab.  
 

 
 
This is an example of the final positioning of the elements 
  

Second floor Roof floor 

Status First floor 
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Step Action 

9 In the Rule settings window select the node level where the rule has to be 
applied: 
 

 
 
The options are: 
 

 Current node (default) 
 Current Level 
 All Nodes 

 

10 After the Node level has been selected, check Override other rules if you want 
to delete any rules that have been previously created.  Note: See Priority order 
of rules for more information 

Press the OK button to save the rule 

11 Click on Save Layout from the Layout tab: a confirm dialog will appear. 

 

12 Click Exit layout editing from the Layout tab to exit editing 

 
 
Note: The Layout must be assigned to the user who accesses the CPY webserver. 
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24.4.2 Create a new Layout from an existing Layout. 
You can create a new Layout starting from an existing Layout. Follow this procedure: 

 

Step Action 

1 Click on Edit layout from the Layout tab 

2 Click on New layout from the existing selector in the Layout settings window 

 

3 From the Layout combo-box select the Layout you want to use as a Template 

Note: The Device type cannot be changed 

4 Select the type of Device that the current Layout is associated to: 

 Single monitor 

 Multi monitor 

Note: see Single screen or Multi screen 

5 Enter a name for the one newly copied in the Layout name field 

6 Click the OK button to close the window. Now you are in edit layout mode 

7 Follow steps 6-12 of Create a new Layout procedure 
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24.4.3 Edit an existing Layout 
You can modify an existing Layout, for example to make some changes after the Layout 
creation. Follow this procedure: 

Step Action 

1 Click on the Edit layout tab from the Layout tab 

2 Click on the Edit existing layout selector in the Layout settings window 

 

3 From the Layout combo-box select the Layout you want to modify 

Note: The Device type and the Layout name cannot be changed 

4 Click the OK button to close the window. Now you are in edit layout mode 

5 Follow steps 6-12 of Create a new Layout procedure 

 
 

24.4.4  Delete a Layout 
To delete a Layout, follow this procedure: 

 

Step Action 

1 Click on the Edit layout tab from the Layout tab 

2 Click on the Edit existing layout selector in the Layout settings window 

 

3 From the Layout combo-box select the Layout you want to delete 
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Step Action 

4 Click on the Delete layout button: the following dialog will appear 

 

Click on the Yes button to delete the selected Layout. Click on the No button 

to go back to the Layout setting window.  

5 The following dialog confirms that the operation has been completed 

successfully. 
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24.5 Operations with the Layout 

24.5.1 Pin the window 

In the top-right corner of the drawing window there are three buttons: 

 

 

Normally if you click on a node, the previous element (drawing window) will be hidden 

and the new elements of the selected node will be shown in the dashboard area. 

You can make the window always-on-top by clicking on the pin icon: the window will 

also be shown if you change the node selection, until you are logged-in. 
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25 ALARMS 

25.1 User interface 

By clicking on  Alarms tab from the navigation bar, the following menu will appear: 

 

 
 
 
The Alarms menu allows you to set time and utilization limits for the bays and groups of 
the Car Park project. It will inform you if Car Park activity goes beyond these limits, as 
well as if technical problems should arise. The alarm system is invaluable in maintaining 
an overview of the parking lot. This is especially true for large scale Carparks. 
 
 

Section Features 

Alarms status Shows the current active alarms 

Alarms history Shows the alarms that occurred in a selected period  

Groups alarms settings Defines the minimum percentage of bays that should be 
vacant in a selected group 

Bays alarms settings Defines the maximum time that a bay should be occupied 

 
 

Note: Whenever an alarm is active, the Alarm tab will change to a warning sign, and the  icon 
will blink. 
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25.1.1 Status tab 
The Alarms status window shows the alarms that are currently active: 
 

 
 
The window has the following elements: 
 

Area Description 

A 
 

Button Action 

Acknowledge This button allows the acknowledge action for a 
selected alarm 

Note: your user account must have the right 
permissions to acknowledge an alarm for this button 
to be enabled. See the account section 

Excel This button allows the export of the current alarms to 
an Excel file 

Hide acknowledged This check-box hides the alarms that have been 
acknowledged 

 

A B 
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Area Description 

B 
 
The Active Alarms section shows the active alarms: 
 

Field  Description 

Alarm On The point in time when the alarm was registered 

Source The source of the alarm: this can be a specific bay, a group 
or a UWP 3.0 controller 

Name 
The name of the specific Group/Bay/MCG network that set 
off the alarm 

Code 
The alarm code, a unique identifier of the type of alarm 
shown 

Text 
A brief description of the alarm type 

Acknowledged 
The point in time when the alarm was acknowledged. If 
the alarm has not been acknowledged this field will be 
blank 
 

User name 
The user who acknowledged the alarm. If the alarm has 
not been acknowledged this field will be blank 
 

  
 

25.2  Procedures 

25.2.1 Acknowledge an alarm 
This will not clear the alarm. It simply announces to other users that you have seen the alarm and 
presumably plan to take action to rectify the problem. This way, other users know that they do not 
need to take action. 
 
Follow this procedure to acknowledge an alarm: 
 

Step Action 

1 Click on Alarms status from Alarms menu 

2 Select an active alarm from the table (B area) 

Note: you can check Hide acknowledge option to hide the alarms that have 
been acknowledged. 

3 Press Acknowledge button 
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25.3  User interface 

25.3.1 Alarms History tab 
The Alarms History window lets you view alarms from a selected period; that is, alarms which 
have occurred and disappeared (no longer active). This feature is particularly useful when you are 
identifying re-occurring issues in your current carpark configuration. 
 

 
 
 

Area Description 

A 
 
Filter options allow you to select the required period from which you wish to view 
historical alarms. The filter has these fields: 
 

Field Description 

From This field defines the earliest point in time when an alarm 
could have occurred to be included in the results 

To This field specifies the filter ending point in time when an 
alarm could have occurred to be included in the results 

Excel 

 

This button allows for the export of all displayed historical 
alarms to an Excel .xlsx file 

Hide 
acknowledged 

This check-box, when selected, hides the alarms that have 
been acknowledged  

Note: This window can be hidden with the button  

A B 
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Area Description 

B 
 
The Alarms table shows the historical alarms that occurred in the selected period.  
It has the following fields: 
 

Field Description 

Alarm On The point in time when the alarm was registered 

Alarm Off The point in time when the alarm stopped being active 

Source The source of the alarm: this can be a specific bay, a group 
or a UWP 3.0 

Name The name of the specific Group/Bay/Network that set off the 
alarm 

Code The alarm code, a unique identifier of the type of alarm 
shown 

Text A brief description of the alarm type 

Acknowledged The point in time when the alarm was acknowledged. If the 
alarm has not been acknowledged this field will be blank 

User name The user who acknowledged the alarm. If the alarm has not 
been acknowledged this field will be blank 

 

 

25.4  Procedures 

25.4.1 Show the alarms which occurred in a selected period 
Follow this procedure to show the alarms that occurred in a selected period: 

Step Action 

1 
Click on Alarm history from Alarms menu 

2 
In the From field, click on the  icon 
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Step Action 

3 
From the popup calendar select the start date 

 

 

 

 

 

The hour can be edited by clicking on it and entering the time desired. 

4 
In the To field, click on the  icon 

5 
In the popup calendar select the end date to define the filter end point. 

Note: the current time is selected as the predefined end point 

6 Once the filter has been adjusted to match your criteria, press the Apply button to update 
the query with the new preferences 

7 Optional step: you can press the Excel button to save all the historical alarms to an .xlsx 
file 

 

Note: to hide the alarms that have been acknowledged, check the Hide acknowledged checkbox 

  

Click on the arrows to select the month through 
months 

Click on the month to select the year 
through years 



 

   

                                                

 CPY Server - Manual                        170 

 

 

25.5  User interface 

25.5.1 Groups alarms settings 
The Groups alarms settings window lets you define the minimum percentage of bays that 
should be vacant in a group at any given point in time. The percentage can also be set for specific 
categories of bays, such as Disabled, Reserved, etc… 

Note: ONLY the users that have the permission can view these settings. 

 

 
 
 

Area Description 

A 
 
In the Quick settings section, you can define global rules for all the categories of 
the group selected in the Carpark section. 
 

Option Description 

Carpark  
(groups structure) 

This field enables you to choose the group from which 
the displayed data should originate 

Enable all 
categories  

This button enables all the categories of the selected 
group 

Disable all 
categories 

This button disables all the categories of the selected 
group 

Set percentage 
for all categories 

This field sets a threshold On value for all the 
categories of the Car Park project 

Set percentage 
for all categories 

This field sets a threshold Off value for all the 
categories of the Car Park project 

 

A B 
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Area Description 

B 
 
The table for these settings has a row for each enabled category of the selected 
group. The fields are as follows: 
 

Field Description 

Category The name of the category  

Note: All categories row defines whether a minimum free 
bays limit is enabled for all categories of the selected 
group. 

Bays The total number of bays for each selected category 

Alm. status The Alarm status for each threshold rule 

Note: an active alarm cannot be deactivated 

Enable This defines if a category is eligible for the threshold rule 

Threshold On (%) When the percentage of vacant bays of the selected 
category falls below this value, the alarm goes On for this 
category 

Bays(#)  The number of bays corresponding to the Threshold On 
(%) value 

Threshold Off (%) When the percentage of vacant bays of the selected 
category rises above this value, the alarm goes Off for this 
category 

Bays(#) The number of bays corresponding to the Threshold Off 
(%) value 

Sequence On The sequence will be activated when the alarm goes On 

Sequence Off The sequence will be activated when the alarm goes Off 

Book category The category in which the bays will be occupied 

N. to book The number of bays to be reserved, picked up by the 
category set in Book category combo-box 

 

 

25.6  Things to know 

25.6.1 About the threshold rule 
The Groups alarms configuration window provides a feature used to specify rising or 
falling threshold rules based on the vacant/occupied status of the bays in the Car Park 
project. When the threshold is reached, depending on the defined limit, a set of actions 
can be performed, as follows: 
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 Book a specific number of bays from a specific category. 

 Run a sequence 

25.6.1.1 Example - Book n bays 

For the Disabled category, a rule is defined to book 1 bay from the Normal category, when 
the number of vacant bays for Disabled goes below a specific value. The available 
categories are defined as follows: 

Category N° of bays 

Normal  10 

Disabled 2 

 

The threshold rule is set in the Group alams configuration window as follows: 

 

 

The table below shows an events example: 

Status Alarm status Disabled 

Vacant / Total 

Total Normal 

The system is in a normal 
condition 

 

INACTIVE 2/2 (100%) 10 
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Status Alarm status Disabled 

Vacant / Total 

Total Normal 

When less than 50% of Disabled 
bays are vacant, the Alarm 
condition will be activated 

 

ACTIVE 1/2 (50%) 10 

As a result of the Alarm 
condition a bay has been 
booked from Normal category 

 

ACTIVE 2/3 (<50%) 9 

The Alarm condition is still active 
till the number of disabled bays 
goes above 3 

 

ACTIVE 3/3 (>51%) 9 
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Status Alarm status Disabled 

Vacant / Total 

Total Normal 

The Alarm condition will be 
deactivated and the booked bays 
will be reassigned to the Normal 
category 

 

INACTIVE 2/2 10 

 

Note: The CPY calculates the number of bays from the set percentage. 

Note: The Alm. status field shows the alarm status condition. 

 

 

  



 

   

                                                

 CPY Server - Manual                        175 

 

 

25.7  Procedures 

25.7.1 Book bays with a threshold rule 
To define a new rule, e.g. as shown above, follow this procedure: 

 

Step Action 

1 Click on Groups alarms settings from the Alarms menu 

2 In the Carpark tree view select a group (node): the relevant bays will be shown 
in the table on the right 

3 In the Enable column select the  check box to enable the required categories 

4 In the Threshold On (%) insert the percentage value and press ENTER 

Note: in the Bays(#) field, the system shows the number of bays 

e.g. Category has 50 bays -> Threshold On (%): 20% -> Bays(#): 10 bays 

Note2: The Threshold ON value must be smaller than Threshold OFF 

 

5 In the Threshold Off (%) insert the percentage value and press ENTER  

Note: in the Bays(#) column the system shows the number of bays 

e.g. Category has 50 bays -> Threshold Off (%): 22% -> Bays(#): 11 bays 

Note2: The Threshold OFF value must be greater than Threshold ON 

 

6 In the Sequence On you can set a sequence that will be executed when the 
alarm goes On 

Note: The Sequences have to be defined in the UWP 3.0 Tool 

7 In the Sequence Off you can set a sequence that will be executed when the 
alarm goes Off 

Note: The Sequences have to be defined in the UWP 3.0 Tool 

8 In the Book category combo-box select the category into which the bays will 
be occupied 

9 In the N. to book field enter the number of bays to be occupied 



 

   

                                                

 CPY Server - Manual                        176 

 

 

Step Action 

10 In the Quick settings section click the Save button to save the changes 

 

25.7.2 Book bays with a global threshold rule 
All category rows, available for each virtual group of the Car Park project, can be used to 
set global rules for all the categories. The procedure is the same as for the individual rules. 

  



 

   

                                                

 CPY Server - Manual                        177 

 

 

25.8 User interface  

25.8.1 Bay alarms settings 
The Bay alarms settings window allows you to set time limits on occupation periods, as 
well as vacant periods, for each individual bay in a group.  
 

 
 
Note: All users can view the Bay alarms settings, although your user account must 
have special permission to modify them. 
 

Area Description 

A 
In the Quick settings section, you can define global rules for all the bays in the 
group selected in the Carpark tree view. The fields are as follows: 
 

Option Description 

Carpark  
(Groups tree view) 

This field lets you choose the group that the data 
shown should originate from 

Enable max 
vacant time 
(d.hh:mm) 

This option lets you assign the Max vacant time for all 
bays in the selected virtual group 

Note: The times in this field have the following format: 
[days].[hours]:[minutes] 

Enable max 
occupied time 
(d.hh:mm) 

This option let you assign the Max occupied time for 
all bays in the selected virtual group 

Note: The times in this field have the following format: 
[days].[hours]:[minutes] 

 

A B 



 

   

                                                

 CPY Server - Manual                        178 

 

 

Area Description 

B 
The table for these settings shows a row for each bay present in the selected Virtual 
group. The fields are as follows: 
 

Field Description 

Name This defines the name of the bay the alarm settings 
belong to 

Max vacant time 
enabled 

This indicates whether or not the maximum limit for how 
long a bay can be vacant is enabled 

Max vacant time The amount of time that the bay in question can be 
vacant before an alarm is triggered. This requires the 
Max vacant time enabled checkbox to be checked 

Use sequence When the Max vacant time is reached, a sequence can 
be activated 

Sequence The sequence will be activated when the Max vacant 
time is reached  

Max occupied 
time enabled 

This indicates whether or not the maximum limit for how 
long a bay can be occupied is enabled 

Max occupied 
time 

The amount of time that the bay in question can be 
occupied before an alarm is triggered. This requires the 
Max occupied time enabled checkbox to be checked 

Use sequence When the Max occupied time is reached, a sequence 
can be activated  

Sequence The sequence will be activated when the Max occupied 
time is reached  

Set event based 
category 

In the Set event based category column select the  
check box to enable for the selected bay 

Event based 
category 

In the Event based categories combo-box select the 
category into which the bays will be occupied 

  

25.9  Things to know 

25.9.1 About the threshold rule 
By setting an alarm to go ON when an occupation period exceeds the maximum 
occupation time, you can ensure that the users are not staying longer than they are 
permitted. Meanwhile, a limitation on the amount of time a bay can be vacant is a good 
way to ensure that your Car Park project is being fully utilized.  
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25.10 Procedures 

25.10.1 Set a Max vacant time / Max occupied time 
Follow this procedure to set a max vacant and/or Max occupied time for the bays of a 
virtual group, individually: 

 

Step Action 

1 
Click on Bays alarms settings from the Alarms menu 

2 
In the Carpark tree view select a virtual group: the relevant bays will be shown in the 
table on the right  

3 
In the Max vacant time enabled column select the  check box to enable the required 
bays 

4 
In the Max vacant time insert the value and press ENTER 

Note: if the time you have entered does not match the format [days].[hours]:[minutes], 
you will be unable to deselect the field until this is corrected 

5 
In the Use sequence column select the  check box to enable the required bays 

6 In the Sequence you can set a sequence that will be executed when the Max vacant 
time value is reached 

Note: The Sequences have to be defined in the UWP 3.0 Tool 

7 In the Max occupied time enabled column select the  check box to enable the required 
bays 

8 In the Max occupied time insert the value and press ENTER 

Note: if the time you have entered does not match the format [days].[hours]:[minutes], 
you will be unable to deselect the field until this is corrected 

9 In the Use sequence column select the  check box to enable the required bays 

10 In the Sequence you can set a sequence that will be executed when the Max occupied 
time value is reached 

Note: The Sequences have to be defined in the UWP 3.0 Tool 

11 In the Set event based category column select the  check box to enable the required 
bays: the selected bays 

12 In the Event based categories combo-box you can select an event based category 
that will be set when the Max vacant time / Max occupied time value is reached 

This functionality permits to change the colour to a bay sensor to distinguish from the 
standard colour for occupy status 

13 In the Quick settings section click the Save button to save the changes 
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25.10.2 Book bays with a global threshold rule 
 
When a time checkbox is checked and the time field has been filled out:  
 

Step Action 

1 
Click on Bays alarms settings from the Alarms menu 

2 
In the Carpark tree view select a virtual group: the relevant bays will be shown in the 
table on the right 

3 
In the Enable max vacant time (d.hh:mm) field select  the check box 

4 
In the box below insert the value and press ENTER 

Note: if the time you have entered does not match the format [days].[hours]:[minutes], 
you will be unable to deselect the field until this is corrected 

5 
In the Enable max occupied time (d.hh:mm) field select the check box 

6 In the box below insert the value and press ENTER 

Note: if the time you have entered does not match the format [days].[hours]:[minutes], 
you will be unable to deselect the field until this is corrected 

7 In the Set event based category field select  the check box 

8 In the combo-box below select the event based category will be applied to all 
corresponding bays in the selected virtual group. 

9 
In the Quick settings section click Apply: the changes will be applied to all 
corresponding bays in the selected virtual group. 
 
Note: If a time checkbox is unchecked and Apply is clicked, all the corresponding time 
limits will be disabled 

 
 
Note: changes made to the field will become permanent when the Save button is clicked. If at any 

point (before clicking Save) you regret any changes made, click the  icon to close the window 
without saving any changes. 
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26 STATUS 

26.1 User interface 

By clicking on |Status tab from the navigation bar, the following menu will appear: 

 

 
 
 
The Status menu allows you to set time and utilization limits for the bays and groups of 
the Car Park project. It will inform you if Car Park activity goes beyond these limits, as 
well as if technical problems should arise. The alarm system is invaluable in maintaining 
an overview of the parking lot. This is especially true for large scale Carparks. 
 
 

Section Features 

Plant status Shows the current active alarms 

Bays status Shows the alarms that occurred in a selected period  

 
 
  



 

   

                                                

 CPY Server - Manual                        182 

 

 

26.2 User interface 

By clicking on Plant status tab from the navigation bar, the Rea time status window will 
appear: 

 

 
 
The Real time status window shows the live occupation status of the various groups of the Car 
Park project, as they are defined in the UWP 3.0 Tool. The status is live in the sense that it is 
continuously monitored by the software.  
 
You can choose to have the collected data illustrated either by: 
 

Section Features 

Graph tab Shows a graphical report of the live occupation 

Table tab Shows a textual report of the live occupation 
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26.2.1 Graph tab 
The Graph tab shows a graphical representation of percentage of bay sensors registered as 
occupied in each group and percentage in the available categories. 
 

 
 

26.2.1.1 Hovering (Show detailed information) 

In the Graph tab, by hovering a coloured section of a group’s bar with the mouse, a tooltip will 
appear with the live occupation details: 
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26.3 Things to know 

26.3.1 Categories 
The Group Status window status bar quantifies the categories of bay sensors. In the example 
above the categories managed are: 
 
 

 
 
It divides these quantities of bay sensors according to their status. This is done to provide a better 
overview of the state occupancy of the parking lot. 
 
 

26.3.2 Unknown status 
When the Car Park project is first configured and started by the UWP 3.0 Tool, it is normal for 
some (if not all) of the sensors to be categorized under the Unknown status for a short period of 
time. This is because the sensors are still being detected and the aforementioned sensor 
occupied delay has not yet elapsed for all of them. However, if the Unknown status persists, 
consult the Alarm > Status section and see if any of the UWP 3.0 masters are experiencing a 
communication error. If so, check the hardware and software configuration in the UWP 3.0 Tool. 
 
  

Node 
 Reserved: total number of bays 
 Disabled: total number of bays 
 Normal: total number of bays 
 Occupied: total number of bays occupied 
 Error: total number of bays in error 

-------------------------------------------------------- 
 Total: total vacant bays 
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26.4 User interface 

26.4.1 Table tab 
The Table tab presents the same data as the Graph tab, but in plain text form.  
 

 
 
In the Table tab you can see a row for each group of the Car Park project. The fields are as 
follows: 
 

Field Description 

Group Shows the group’s name 

Alarms Shows the current active alarm count for the group. See the Alarms 
chapter for more details on this 

Occupied Shows the total number of bays that are occupied in the current group 

Vacant Shows the total number of vacant bays available 

[Category 1] Vacant Shows the vacant bays for category 1 (Default “Normal”) 

[Category 1] 
Occupied 

Shows the occupied bays for category 1 (Default “Normal”) 

[Category 2] Vacant Shows the vacant bays for category 2 (Default “Disabled”) 

[Category 2] 
Occupied 

Shows the occupied bays for category 2 (Default “Disabled”) 

[Category n] Vacant Shows the vacant bays for category n 

[Category n] 
Occupied 

Shows the occupied bays for category n 

Bays Shows the total number of bays for this Group (node) 
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Field Description 

[Category 1] Total Shows the total number of bays (vacant and occupied) for category 1 

[Category 2] Total Shows the total number of bays (vacant and occupied) for category 2 

[Category n] Total Shows the total number of bays (vacant and occupied) for category n  

Error! Shows the total number of bays in Error for the selected group 

 
  



 

   

                                                

 CPY Server - Manual                        187 

 

 

26.5 User interface 

26.5.1 Bays status 
The Bays status window presents the same data as the Graph tab, but in plain text form.  
 

 
 
In the Bays status tab, you can see a row for each group of the Car Park project. The fields are as 
follows: 
 

Field Description 

Bay Shows the bay’s name 

Date and Time Shows the date and time when the event has occurred 

Status Shows the current status of the bay 
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27 REPORT 

27.1 User interface 
The Report menu contains two of the key analysis functions of the CPY webserver. By 
clicking on the Report tab from the navigation bar, the following menu will appear: 

 

 

 

These reports provide an overview of Car Park usage patterns, on a scale varying from a 
single parking bay, to the entire Car Park project (parking lot). 

 

Section Features 

 Occupancy Shows a history report about the occupied/vacant status of a 
selected group of Car Park project 

  Space statistic Shows a detailed report about status of each bay of a selected 
group of Car Park project 

       Settings Set the delta period for the report time interval 

 
 

27.1.1 Report time frame window 
In the Setting tab of the Report menu, you can set the difference between the Start date 
and the End date used by default from the Report functions. 
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27.1.2 Occupancy 
The Occupancy function takes a virtual snapshot of the state of occupancy in each group of the 
Car Park, every fifteen minutes (UTC time). You can choose to have the collected data illustrated 
either: 
 

 Graphically in the Graph tab 
 

 Textually in the Table tab 
 

27.1.3 Graph tab 
The Graph tab contains a chart which illustrates the Car Park occupancy history.  
 

  

Graph tab of Occupancy window 

 
  

A 

B 

C 

D 
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Area Description 

A The filter is used to specify the period of time, as well as the group of the carpark 
where the data shown should stem from. This allows you to specify which part of the 
occupation history you're interested in. By limiting the scope of the data, it becomes 
easier to interpret.  The filter has three fields: 

Filter Description 

Groups This field lets you choose the group (real or virtual) where 
the data shown should originate  

From This field specifies the filter starting point. All occupation 
history data that occurred between this point in time and 
the filter end point will be shown 

To This field specifies the filter ending point 

Note: The window can be hidden with the  button  

B You can switch from Graph tab to Table tab 

C This shows the graph based on the filter set. The graph axes adjust automatically to 
the data requested, in order to present in the most interpretable manner possible. The 
time (horizontal) axis resolution will change in accordance with the length of the 
selected filter period. The longer the period, the lower the resolution. 

By clicking on the  icon you can export the report (see Export the graph in 
different formats ) 

D You can enable or disable the showing of specific statistics by clicking the labels of 
the available categories (C area).  

Note: only the Graph tab shows the group categories 
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27.1.4 Table tab 
The Table tab shows the same data as the Graph tab. By clicking on Table tab from the  
Occupancy window, the following interface will appear: 

 

 

Table tab of Occupancy window 

 
 

Area Description 

A The header row shows the columns of the table 

B The table reports the results of the chart as text  

 

Note: Like the Graph tab, this will adjust its time resolution in accordance with the selected 
filter period.  

  

B 

A 
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27.2  Things to know  

27.2.1 Customizable items of a report 
You can customize the following report items: 

 

Tab Items 

Graph  

 

 Show / hide categories 

 Show / hide statuses 

Table  

 

 Column position 

 Sort the data into Ascending/Descending order by column  

 

27.2.2 Elements in the graph 
As well as showing which of the total parking spaces are occupied/vacant, the chart also 
shows detailed data for all the categories managed in the Car Park project. See 
Status/Categories setup. 

In addition to the occupied/vacant statuses, the chart also shows how many of the total 
disabled bays are occupied, as well as which spaces are booked and how many of these 
are occupied. The chart goes on to illustrate traffic patterns and, if an error should occur, 
it will illustrate this too. 
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All the categories and statuses managed by the Car Park project are reported below the 
current graph (see the red rectangle in the picture above) with a label for each category 
(occupied/vacant) 

After you create a report, you can select which elements you want to show in a chart.  

The elements which can be shown in the chart are: 

 Category (Disabled, VIP etc..) 

 Bay status (e.g. if the real bay sensor is in Error condition) 

 Traffic [cars/hour] 

 

27.3  Procedures 

27.3.1 Create a new report (Graph/Table) 
Follow this procedure to create a new report: 

Step Action 

1 Click on Occupancy from the Report menu 

2 In the Filter section  Groups, select the desired group 

3 In the From field, click on the   icon 

4 In the popup calendar select the start date 

 

 

 

 

 

The hour can be edited by clicking on it and entering the desired time. 

Note: The start date must be before the end date 

5 In the To field, click on the   icon 

6 In the popup calendar select the end date to define the filter end point. 

Note: the current time is set as the predefined end point 

Click on the arrows to select the month through 
months 

Click on the month to select the year 
through years 
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Step Action 

7 Once the filter has been adjusted to match your criteria, press the Apply button 
to update with the new preference.  

Note: If you change the current group (the node on the tree), the graph/table will 
be generated automatically without pressing the Apply button 

 

27.3.2 Show / hide elements in the graph 
In order to show/hide the different elements, follow this procedure: 

Step Action 

1 Create a new report if you don't have an already existing one 

2 At the bottom of the chart, click on one or more text labels of the categories, in 
order to hide/show from current view: 

 

3 In the example below, the  Occupied category has been hidden 

 

 

Note: This selection does not affect the data in the Table tab, but it affects the list shown 
in the tooltip and reports that can be saved from the graph. 
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27.3.3 Show the status in the tooltip 
The tooltip is a little box that pops up when you hover the mouse over the chart area. The 
tooltip content is automatically generated based on the elements available for the chart.  

You can see the tooltip by hovering your mouse over any part of the chart area. It shows, 
in text format, the status of the Car Park at the exact moment the mouse pointer is placed. 

 

 
 

Note: the data represented in the tooltip popup based on the label selected at the bottom 
part of the chart 
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27.3.4 Export the graph in different formats 
You can export the generated report into one of the available file formats, e.g. a CSV file 
or an XLS table. There are also different image formats available to save it as a graph.  

 

Step Action 

1 Create a new report if you don't have an already existing one 

2 In the top-right part of the chart area (see the red rectangle below),  

click on the  icon: 

 

 

3 Select one of the format files to save it. 

Note: Depending on your browser settings, there are different ways to 
download files: please refer to the download setting of the browser used. 

 

27.3.5 Sort the contents of a table report 

Step Action 

1 Create a new report if you don't have an already existing one 

2 Select Table tab from the Occupancy window 

3 From the header row, click the  icon next to the required box, then: 

 click  to sort in ascending alphanumeric order (Sort A to Z) 

 click  to sort in descending alphanumeric order (Sort Z to A)  
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27.4  User interface  

27.4.1 Space statistic  
The space statistic function focuses on the analysis of parking bay utilization. It does so by looking 
at the time intervals during which spaces have been occupied and generating statistics by 
comparing these intervals to each other in the context of the period selected by the user.  
 

 Group tab: the statistics can be viewed for the selected group; 
 

 Space tab: the statistics can be viewed for individual spaces; 
 

 

Space statistic window 

Area Description 

A The filter is used to specify the period of time, as well as the group of the carpark, 
where the data shown should stem from. This allows you to specify which part of the 
occupation history you're interested in. By limiting the scope of the data, it becomes 
easier to interpret.  The filter has three fields: 

Filter Description 

Groups 

structure 

This field lets you choose the group (real or virtual) that the 
data shown should originate from.  

From This field specifies the filter starting point. All occupation 
history data that occurred between this point in time and the 
filter end point will be shown. 

To This field specifies the filter ending point 

Filter short 
events 

If this field is enabled, all the events of the sensors that last 
less than 30 seconds are hidden 

Note: The window can be hidden with the button  

A 

B 

C 
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Area Description 

B You can switch from Group tab to Space tab 

C This section shows the data table based on the group selection 

Refer to the table below for more info about the fields available for Group tab and 
Space tab 

 

27.5  Things to know 

27.5.1 Group tab 
The table found under the Group tab shows the group statistics for all the space sensors 
assigned to the group that the user has selected. If the selected group is subdivided into smaller 
groups, the statistics for these smaller groups will be shown.  
 
The fields of the Group table show the following data: 
 

Permission Description 

Name The group name, as defined in the Configuration of the SBP2CPY 

Counting The number of times a bay has been newly occupied in the group during 
the selected period (the filter period) 

Occupancy time % The percentage of time the group is occupied. Calculated by: 

([The sum of the group’s bay occupancy time] / ([The selected period 
(filter period)] * [number of bays])) * 100 

Used space % The percentage of the parking bays in the selected group that were 
occupied during the selected period 

Minimum time The shortest time interval in which a car was parked in a bay during the 
selected period 

Maximum time The longest time interval in which a car was parked in a bay during the 
selected period 

Average time The average length of the occupation times that occurred in the selected 
period 

Total time The sum of each parking bay’s total occupation time during the selected 
period 

First arrival The starting point of the first occupation time found in the selected period 

Last departure The ending point of the last occupation time found in the selected period. 
Note: be aware that if this is equal to the selected From time, all the 
occupation intervals in the selected period are currently active. This means 
all bays in the group are currently occupied. 
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27.5.2 Space tab 
The table found under the Space tab shows the statistics of each individual bay sensor in the area 
that the user has selected. The fields of the table show the following data: 
 

Permission Description 

Name The sensor’s name, as defined in the UWP 3.0 Tool 

Counting The number of times the bay was occupied during the selected period (the 
filter period) 

Occupancy time % The percentage of time in the selected period that the bay was occupied 

Minimum time The shortest time interval in which a car was parked in the bay during the 
selected period  

Maximum time The longest time interval in which a car was parked in the bay during the 
selected period 

Average time The bay’s average occupation time during the selected period 

Total time The bay's total occupation time in the selected period 

First arrival The starting point of the first occupation interval found in the selected 
period 

Last departure The ending point of the last occupation interval found in the selected 
period. Be aware that if this is equal to the selected From time, the selected 
period only contains an active occupation interval. This means that the bay 
is currently occupied 

 

Note: If a bay associated with the selected group does not appear in the table, it is because 
it has not been occupied during the selected period. 

 

27.5.3 Example 
While the filter has the function of narrowing down the data the software should display, it also 
functions as a cut off point for the occupation intervals being analyzed. 
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The above diagram shows four different scenarios where an occupation interval for a single 
parking bay is filtered. As can be seen in the first scenario (TOP), when the interval starts and 
ends within the filter period, the full interval is analyzed by the software. However, as can be seen 
in the other three scenarios, if any part of an interval lies outside the filter period, it will be 
disregarded by the software.  
 
An example:  there are 10 parking bays in a group. Each of these has been occupied 
during the hour between 9 and 10 in the morning. In the filter you select the group and set From 
time to 09:11:00 and To time to 09:12:59. The resulting output will show that the minimum, 
maximum and average time for all the bays in the group will be 01:59. This is correct, seen in the 
context of the selected filter period, but it can be misleading. 
 

Note: In order to avoid confusion it is recommended that you: 

 

1. Avoid making your filter periods too short. If this advice had been followed in the example 
above, useable statistics would have been acquired. 

 

2. Look at the First Arrival/ Last Departure times. If they fall outside the filter period, then part 
of an interval has been disregarded. 
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27.6 Procedures 

27.6.1 Create a new report (Space statistics) 
Follow this procedure to create a new report: 

Step Action 

1 Click on Space statistics from Report menu 

2 In the Filter section  Groups, select the desired group 

3 In the From field, click on the   icon 

4 In the pop-up calendar select the start date 

 

 

 

 

 

The hour can be edited by clicking on it and entering the time required. 

Note: The start date must be before the end date 

5 In the To field, click on the   icon 

6 In the pop-up calendar select the end date to define the filter end point. 

Note: the current time is set as the predefined end point 

7 Once the filter has been adjusted to match your criteria, press the Apply button 
to update the selection with the new preference.  

Note: If you change the current the node in the tree (the group level you want 
shown), the graph will be generated automatically without pressing the Apply 
button 

 

 

 
 
 
 
 
 

Click on the arrows to select the month through 
months 

Click on the month to select the year 
through years 
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27.6.2 Sort the contents of a table 

Step Action 

1 Create a new report if you don't have an already existing one 

2 From the Space statistics tab in the Occupancy window select: 

 Group tab 

 Space tab 

3 From the header row, click the  icon next to the box required, then: 

 click  to sort in ascending alphanumeric order (Sort A to Z) 

 click  to sort in descending alphanumeric order (Sort Z to A)  
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28 COMMANDS 
If you click on the  Commands tab from the navigation bar, the following menu will 
appear: 

 

The Commands menu includes the following options, as shown below: 

 

Option Features 

+  MZC settings  Reset the value for a MZC group 

 Send a numeric value for a MZC group 

 SBP2WEB/UWP3.0 
sequences 

Execute UWP 3.0 sequences 

Note: the sequences shown are configured from the UWP 3.0 
Tool 
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29 MZC SETTINGS 

29.1 User interface 
If you click on the  Commands tab from the navigation bar, then + MZC settings, the 
following window will appear: 

 
 

 

MZCsettings window 

 

You can Reset or send a specific numeric value to the Master Zone Counter of your Car 
Park project  
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29.2  Procedures 

29.2.1 Reset MZC group 
To reset a Master Zone Counter group, follow this procedure: 
 

Step Action 

1 Click on Commands from the navigation menu, then click the MZC settings 
tab 

2 Click the  Reset button next to the MZC group selected 

3 On the Confirm popup, click the Yes button 

 

 

4 If there is a problem, the system will show the following popup: 

 

Note: please repeat the procedure above; if the problem continues, contact 
technical support 

 

29.2.2 Set a value to a MZC group 
To set a value to a Master Zone Counter, follow this procedure: 
 

Step Action 

1 Click on Commands from the navigation menu, then click the MZC settings 
tab 

2 Enter a numeric value in the Set a value box next to the MZC group selected 

 

3 Click on the  Send button to send the new value to the MZC group 
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Step Action 

4 On the Confirm popup, click the Yes button 

 

 

5 If there is a problem, the system will show the following popup: 

 

Note: please repeat the procedure above; if the problem continues, contact 
technical support 
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30 UWP 3.0 SEQUENCES 

30.1 User interface 
If you click on the  Commands tab from the navigation bar, then SBP2WEB/UWP 3.0 
sequence, the following window will appear: 

 
 

 

UWP 3.0 sequences window 

 

The UWP 3.0 sequences window includes two sections, as shown below: 

 

Section Description 

A Shows the list of the sequences of all the UWP 3.0s managed in the current Car 
Park project   

B  Execute selected sequence 

 Reset filter 

  

A

B 
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30.2  Things to know 

30.2.1 Sequences 
The sequences that can be executed from the SBP2CPY can be created from the UWP 
3.0 Tool. The sequences can be related to lights, roller blinds, intruder alarm, sirens, timers 
and zone temperature functions. The sequences must be synchronized with the UWP 3.0 
Tool to the SBP2CPY: please refer to the UWP 3.0 Tool manual. 

30.3 Procedures  
The list of available sequences is shown in the UWP 3.0 sequences window. You can 
adjust it by using the filter options available in the header bar. 

30.3.1 Sort the sequences 
Carry out the following procedure in order to sort the sequences into 
ascending/descending order by column: 
 

Step Action 

1 Click the arrow  in the column you want to sort: 

  

 

Note: each column presents the same filter options, as indicated above. 

2  Click  to sort in ascending alphanumeric order (Sort A to Z)  

 Click  to sort in descending alphanumeric order (Sort Z to A)  

3 You can remove the filter selection by clicking on the Reset filter button 
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30.3.2 Filter by specific text 
Carry out the following procedure in order to filter the sequences by specific text: 
 

Step Action 

1 Click the arrow  in the table header of the column you want to filter 

 

2 Tick the Filters check-box 

3 Enter the text criteria you require in the adjacent box: for example, to show a 
sequence that contains a specific text string, ( e.g. TURN ON) 

  

 

4 The system will provide all the sequences that satisfy the search criteria. 

 

The filter name in the table header changes with underline to indicate a filter is 
applied, as shown in the picture above for the UWP 3.0 column. 

5 You can remove the filter selection by clicking on the Reset filter button 
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30.3.3 Execute an SBP2WEB24/UWP 3.0 sequence 
To execute a sequence, follow this procedure: 
 

Step Action 

1 Click on Commands from the navigation menu, then click the 24/UWP3.0  sequences 
tab 

2 Click the sequence record you want to execute with the left mouse:  it will be 
highlighted in light-blue: 

 

3 Click on   to start the sequence 
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31 APPENDIX 

31.1 Procedures 

31.1.1 Install SH2DSP24 adapter 
To connect the 3G modem adapter, the SH2DSP24 module, you will have to go through 
the following steps: 

 

 Make sure the SBP2CPY24 and the SH2DSP24 are not powered. 

 Connect the SH2DSP24 to the SBP2CPY through the auxiliary bus on the left side 
of the SBP2CPY24. 

 Make sure the SIM is not protected by a PIN code (should that be the case, 
disable the protection). 

 Insert the SIM into the dongle modem through the special slot. 

 Restore the power supply of both devices (SBP2CPY and SH2DSP24). 

 Make sure that both devices are located in a dry place, protected against rain and dust. 

  

On the front of the SH2DSP24 there are two LEDs, which indicate the following: 

1)    Green LED: Steadily on => the equipment is powered. 
2)    Blue LED: Off => no power supply. Fast blinking => searching for the cover signal / not 

registered / switching off. Slow blinking => Service is registered and signal is available. 
Steadily on => communication under way. 
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31.2  Things to know 

31.2.1 TCP/IP networking 

31.2.1.1 Inbound TCP/IP communication 

TCP/IP port number  TCP/IP port description  Purpose 

80 HTTP Access to the internal web-server  

52325 SSH Remote tunnelling feature; connection 
from UWP 3.0 to SBP2CPY24  

 

31.2.1.2 Outbound TCP/IP communication 

 
TCP/IP port number  TCP/IP port description  Purpose 

53 DNS Domain name resolution  

37 NTP Network time services access  

 

31.2.2 SMS commands list 
The following commands are available by sending an SMS to the SH2DSP24 SIM number: 

Command Syntax Notes 

CPY Reboot REBOOT password 

(e.g. REBOOT 1234) 

Password defined by the user in the 
relevant section in the page above; the 
system sends an acknowledgement to 
the calling phone (REBOOT OK) 

Data 
communication 
ON 

DATA MODEM ON password 

(e.g. DATA MODEM ON 1234) 

Password defined by the user in the 
relevant section in the page above; the 
system sends an acknowledgement to 
the calling phone (DATA MODEM ON 
OK) 

Data 
communication 
OFF 

DATA MODEM OFF password 

(e.g. DATA MODEM OFF 1234) 

Password defined by the user in the 
relevant section in the page above; the 
system sends an acknowledgement to 
the calling phone (DATA MODEM OFF 
OK) 

Public IP 
inquiry 

IP password 

(e.g. IP 1234) 

Password defined by the user in the 
relevant section in the page above; the 
system sends the IP address by SMS to 
the calling phone 
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31.2.3 Indicator settings 
Each SBPILED indicator configured in a Car Park project has its own Software version, 
called Software Indicator, and can be added to a Drawing. Each Software Indicator can 
be configured in terms of: 

 
 Appearance: The Software Indicator can be customised in terms of size, label, 

colour of digits, etc… 
 

 Change category: the category can be assigned to all the bays which are part of the 
Indicator function. 

 

By clicking on the  button the following window appears: 

Note: The Indicator settings window is accessible only in Drawing edit mode. 

  

 

Indicator configuration window 

 

 

  

A 

B 

C 

D 
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The Indicator settings window is defined as follows: 

Section Description 

A The Indicators tab section shows the list of indicators available 

B Indicator configuration window 

C The elements list of the Indicator settings window: 
 

Field  Description 

Label Enter text that describes the display: the text will be 
shown in the position defined in the Label position field 

Label position Defines the position where the Label text will be shown 

Label font Defines the label font, size and colour 

Value font Defines the Value font, size and colour 

Width Defines the width of the software display (in pixels) 

Height Defines the height of the software display (in pixels) 

Border width Specifies the width of the display border (in pixels) 

Background 
colour 

Assigns a background colour to the software display 

Border colour Defines the border colour of the software display 

D The preview area shows a preview simulation of the indicator element 
shown in the drawing 
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31.3  Procedures 

31.3.1 Add an Indicator from the Indicator tab 
Follow this procedure to add a Software Indicator in a drawing: 

Step Action 

1 Open the Drawing window where you want to add a Software Indicator 

2 
Click on   Edit from the Drawing toolbar 

3 Click on the Indicators tab from the Left Panel  

 

4 From the Indicators tab click on the text of the selected Indicator 

Note: The selected indicator will be highlighted in light blue 

5 Click the left mouse button on the area where you want to put the Software 
Indicator element 
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31.3.2 Edit a Software Indicator   

A Software indicator can be edited by clicking on the  icon from the Drawing toolbar. 
Follow this procedure: 

Step Action 

6 

The indicator will be added to the drawing 

 
 

You can edit the indicator by clicking on the  Display configuration 
button. See the procedure Edit a Software Indicator 
 

Step Action 

1 Adding a Software Indicator to a drawing 

2 Click the Software Indicator with the left mouse button to select it: 

 

Note: a light-blue box with the drag point appears around the selected 
Software indicator   

3 Click on the  Display settings button from the command bar: The 
Indicator settings window will appear: 
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Step Action 

 

4 
Edit all the fields required (see Indicator settings for detailed information) 

Note: you can click on the Preview button to see the appearance 

5 Click on the Indicator configuration button for additional settings 

6 Click on the Save button to save the changes. 
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31.3.3 Indicator configuration and commands  
The Indicator configuration button opens the configuration window, in which you can 
configure the following parameters: 
 

 

 

Indicator configuration window 

 
The Indicator configuration window includes these sections: 
 

Section Description 

A Change category 

You can set the category to which the bays belong 

B Set Vacant 

The SBPILED LED is lit up in [default colour for set category] 

Set Occupied 

The SBPILED LED is lit up in RED [default colour for Occupied status] 

 
  

B A 
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31.3.4 Send command to an Indicator 
To send a command to an Indicator, follow this procedure: 

 
  

Step Action 

1 Enter Drawing in edit mode 

2 Select a Software Indicator from the drawing 

3 Click on the Indicator configuration button from the Indicator settings 
window 

4 In the Indicator command section, click on the command you need in 
order to perform the test. The following message will appear to confirm the 
command has been sent successfully: 

  

5 Click on the X button to close the Indicator configuration window 

6 

Note: When a command is sent to an Indicator, a small red dot icon will 
appear in the Drawing window (see below). It will remain for as long as the 
command is active 
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31.3.5 Delete an Indicator 
To delete an Indicator from a drawing, follow this procedure:  
 

 

 

Step Action 

1 Open Drawing in edit mode 

2 Select the Indicator you want to delete 

 

Note: The Indicator will be highlighted with a light blue rectangle 

3 Click on the  Delete button and click on Save drawing to delete the 
Indicator from the drawing 
 

 

 
Note: If you exit without clicking on Save, the Indicator will not be deleted 
 
Note 2: Although the indicator is deleted, the association of the bays to it 
will not. To dissociate it, the configuration on the UWP 3.0 Tool must be 
changed. 
 


